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Introduction 

Overview 

 

 

 

LASER PROGRAMMING AND NESTING SOFTWARE 

VERSION 6.2 

 

The CINCINNATI Laser Programming and Nesting Software is used to generate highly 
efficient NC code for CINCINNATI Laser Systems.  It was designed to be both simple to use 
for novices and flexible enough to allow experienced users the ability to program very 
complex parts. 

 

For an overview of the new features in this version, please refer to “What’s New”.  

Copy Protection 
The CINCINNATI Laser Programming and Nesting software is copy protected and requires a 
hardware key to operate.  This hardware key called a "Hardlock" or “Hasp” and must be 
plugged into a parallel port or USB port on the computer whenever the software is running.  
The following message will be displayed if the software cannot locate the hardware lock : 
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If this message appears when the application is started, check to make sure the Hardlock is 
securely plugged into the proper port on the computer.  Additional diagnostic help with 
hardware locks is available in the Hardware Lock Troubleshooting section. 

Expiration Date 
 The CINCINNATI Laser Programming and Nesting software is licensed for use for a period of one 

year after the purchase date.  After this time, the software license must be renewed by 
contacting CINCINNATI INCORPORATED.  The expiration date of the software can be 
determined by displaying the "About LsrNest" window.    This is done by selecting the "About 
LsrNest" option under the Help menu or pressing the "About" toolbar button. 

            

 

If the expiration date is within 30 days of the current date, the following reminder will be 
displayed when the software is started: 
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To extend the license, contact the CINCINNATI INCORPORATED Parts Department.  You 
will need to supply the serial number of the software to obtain an extension.  This serial 
number is displayed on both of the above screens. 

You will be given a 16-character alphanumeric license code by the Parts Department to 
extend the license.  Once you have the 16-character code, press the "Extend License" button 
on either of the above screens and the following dialog will be displayed: 

                      

Enter the 16-character code in the blank field and press the OK button.  If the code was 
entered properly, the "About LsrNest" window will show the new expiration date.  

 

  

Software Updates 
The Laser Programming and Nesting software can contact the CINCINNATI 
INCORPORATED web site over the Internet and check for software updates. This is done by 
selecting the Check for Updates option under the Help menu. 
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When this is selected, the software will attempt to contact the CINCINNATI web site and 
check for available updates.  If the no software updates are available, the following dialog will 
be displayed: 

 

 

If an update is available, a dialog will be displayed asking whether or not the user would like 
to update the software. 

 

 

Pressing the Update button will begin the download process.  When the download is 
complete, the software will automatically be updated.   

 

An alternative way to update the software is to log in the Customer Information Center on 
the CINCINNATI INCORPORATED web site, www.e-ci.com .  The file download area 
contains the latest version of the Laser Programming and Nesting software. 
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What’s New 

Overview 
This section describes the changes to the software made in the different versions.  It is 
intended to give current users who are upgrading their software a quick overview of new 
features available in the software. 

 

Version 6.0 

Support for AutoCAD 2013 files 

The nesting software will now open DWG and DXF files created with AutoCAD 2013.   

PDF Report files 

You can now create PDF report files, which contain pictures of the parts and nest layouts in 
the report.   

A new shape added to the shape library 

A new shape was added to the shape library: a link.   

Support for CL-400 laser systems 

The software now supports the CL-400 laser systems.  

Support for the Vision System option 

The software now supports laser systems equipped with the Vision System option. 

Backup and Restore Configurations 

You can now backup and restore the configuration and library files used by the nesting 
software.  This can make copying settings between computers much easier. 

Option to Easily Change Kerf Width in NC program 

The software can now post a kerf width assignment before each feature.  This allows the kerf 
width to be edited for individual features if needed to tweak part accuracy.  This is enabled on 
the Process Parameters configuration page. 

Bug Fixes and Minor Enhancements 

The following bug fixes and minor enhancements are also included in this version of the 
software: 

• Hole missing from customer’s part. 
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• Report file lists library files that aren’t used. 

• Don’t ignore etched exteriors of parts when nesting. 

• Part run times in report file can be incorrect. 

Version 6.1 

Etch Order Number Text 

You can add an etched text entity to a part that will be changed to the Order Number value 
when the NC code is posted.  This allows the same part file to be nested for different orders 
and sorted after they are cut.  

Allow dwells between motion blocks 

You can now specify a dwell at the intersection of any two motion blocks.   

New shapes added to the shape library 

Three new shapes were added to the shape library: a Shim, Pulley Cover and Rectangular 
cover.   

New arc feedrate formula for CL-800, CL-900 and CL-400 lasers 

The arc feedrate formula was modified slightly for the above lasers.   

Bug Fixes and Minor Enhancements 

The following bug fixes and minor enhancements are also included in this version of the 
software: 

• Estimated run times for CL-900 and CL-400 may be too large. 

• Software may crash if large CNC file is opened.. 

• Improve feature avoidance by optimizing lead in location. 

• Improved endpoint tolerance checking 

• Parts with tabs do not display correctly in PDF report files. 

• Zooming is now centered on the cursor instead of the center of the window. 

• Slug cut moves have an exact stop when the direction changes. 

• Allow multi-select when adding sheets to a nest. 

• Text report enhancements. 

 

Version 6.2 

New shapes added to the shape library 

Three new shapes were added to the shape library: a Single Shim, Offset Slots and 
Rectangular cover with 2 holes.   

Add new Fixture Nest location selection 
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A new fixture nesting location selection was added that allows the user to offset the part on 
the sheet from the edge that is closest to the edge of the machine.  This makes Fixture 
Nesting more useful when used with the Vision System option.  

Bug Fixes and Minor Enhancements 

The following bug fixes and minor enhancements are also included in this version of the 
software: 

• Ramped starts can cause extra circles in part. 

• Duplicate line numbers with combination of All Pierces First and Slug Cut up 

• Part Setup notes missing from PDF report and Nest plot 

• Add the configuration name as a comment in the NC code 

• Estimated cutting time can be inflated when all pierces first is done 

• Very long part names can cause the software to crash when nesting 

• Adding exact stops to all intersections should ignore "phantom" intersections in arcs. 

• Remember last setting of “Complete all Pierces first sub-options” and “Complete all 
Etching before Cutting” 

• Nest layout picture in PDF report may be clipped 

 

Configuration 

Overview 
The CINCINNATI Laser Programming and Nesting software can be configured to generate 
NC code for a variety of CINCINNATI Laser Systems.   To review or edit the configuration 
either, 

1. Select “Configuration” under the File menu, or 

2. Press Ctrl G, or 

3. Click on the Configuration icon on the toolbar:   
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The Configuration dialog is made of several different pages.  You can select different pages 
by clicking on the different tabs at the top of the dialog.   The following sections will explain 
each individual configuration page. 

Machine Configuration 

 

   Machine Configuration Page 

Current Configuration  

This section shows the name of the current configuration file being used by the Laser 
Programming and Nesting software.  Many different configurations can be set up however 
only one configuration is active at a time.  Multiple configurations will be useful for customers 
who have several different CINCINNATI Lasers. 

To select a different configuration, select a different name in the drop down list box.  The 
following configuration files are supplied with the software: 

CL5-1350W, CL5-1700W, CL5-2000W 

CL7-1350W, CL7-1700W, CL7-2000W 
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CL6-1500W, CL6-2000W, CL6-3000W 

CL6-160i-1500W, CL6-160i-2000W, CL6-160i-3000W, CL6-160i-4000W 

CL7A-1350W, CL7A-2000W, CL7A-2500W, CL7A-PC-3000W, CL7A-PC-3300W,  
CL7A-PC-4000W 

CL707-1350W, CL707-2000W, CL707-2500W, CL707-FP-2500W, 
CL707-FP-3000W, CL707-FP-3300W, CL707-FP-4000W 

CL850, CL840, CL440, CL920, CL940 

The Rename button is used to rename the current configuration file.  

The New button is used to create a new configuration file.   All of the settings for the current 
configuration are copied to the new configuration. 

The Delete button is used to delete the current configuration file.   

Configuration File Path – The software defaults to having the configuration files stored in 
the main application directory.  This can be changed if desired by using the Browse button. 

Machine 

The Machine Type can be set to CL-900 (Fiber), CL-400 (PRC), CL-800 (FNC), CL-800 (DC), 
CL-707 (SM), CL-707 (DC), CL-707 (FNC), CL-6, CL-6 160i, CL-7A (SM), CL-7A (DC), CL-7A 
PC (DC), CL-7A PC (FNC), or Generic Post.   

The Machine Size can be set to 4x8, 5x10, 6x12,  8x20, or Other.  Changing this value also 
changes the Travel Limits section. 

Travel Limits 

This set the maximum travel distance of the machine.  This is typically ½” larger than the 
machine size. 

Arc Feedrate Parms 

These values are used to calculate the maximum feedrate for circular (G02 and G03) moves 
that maintains the desired radius tolerance.  The nesting software calculates the maximum 
feedrate using the following formula: 

)T - (T RKfeedrate 0××=           (Equation A) 

where R = radius of arc,  T = desired tolerance and 

 K T0 

CL-800, CL-900, CL-400 (See 
below) 

18000 0.00045 

CL-707 Fastpack 26500 0.0002 

CL-707 8 x 20, CL-900 8 x 20 18000 0.0010 

CL-707 Pre-fastpack  18000 0.0002 

CL-7A PC 6000 0.0010 

CL-6, CL-7A Lookahead On 6000 0.0010 

CL-6, CL-7A Lookahead Off 4242 0.0010 

If the calculated feedrate exceeds the straight line material feedrate, the material feedrate will 
be used instead.  If the calculated value is less than the minimum arc feedrate, the minimum 
arc feedrate will be used. 

CL-800, CL-900, CL-400 Lasers Only 
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These laser systems use a more complicated arc feedrate calculation based on Equation A 
above and Equation B below.  Equation A is used until the feedrate calculated using it 
exceeds the feedrate calculated by Equation B.  This is typically >1300 IPM, see the graph 
below: 

 

 

Equation B is given below: 

 

 

 

Note: If a part contains arcs whose radius tolerance value is less than or equal to the T0 
value, the following warning dialog will appear when NC code is created: 
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Pressing the Ignore Warning button will make the software use the programmed tolerance 
values, which will result in the minimum arc feedrate value being posted for those arcs.  
Pressing the Increase Tolerance button will temporarily increase (for this NC code only) the 
tolerance value to T0 + 0.001".  This can be useful when posting code from the same part file 
for two different lasers that have different T0 values. 

Don’t slow down etching – If  this checkbox is checked, etched arcs will not be subjected to 
feedrate restrictions. 

Default Clamp Zones 

These values can be used to define rectangular areas in which the nesting software will not 
place parts.   These are default values that are copied to each new sheet as it is added to a 
nest.  See the Sheet List section for further information. 

Repositioning 

This value determines whether or not manual sheet repositioning can be used to cut 
oversized sheets.  The possible values are None [default], Manual (in load frame), Manual (in 
main frame).  For more information on repositioning, see the Manual Repositioning section. 

Backup Configs 

This button is used to create a backup ZIP file of all configuration files and material library 
files installed with the software.    This file can be used to copy configurations to a new 
computer. 

Restore Configs 

This button is used to restore all the configurations and library files from a backup file created 
with the “Backup Configs”  button.    
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Process Parameters 

 

         Process Parameters page for CL-400, CL-800, CL-900, CL-707, CL-7A PC and CL6-160i 

Material List 

The material list ties a material and a process type to a library file (CL-400, CL-800, CL-900, 
CL-707, CL-7A PC and CL-6 160i) or a code number (CL-6 and CL-7A) to define cutting 
parameters and a process feedrate. The list can be sorted by double clicking on any of the 
category titles.   

Weight Column – This column is used to calculate the estimated weight of the parts.  The 
default values used are: 

 0.284 lb./in³ - Steel 

 0.100 lb./in³ - Aluminum 

Insert – Press this button to add a new entry to the material list. 

Copy – This button copies the current selection in the material list to a new entry. 

Delete – This button deletes the current selection from the list. 
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Edit Library – Pressing this button allows the cutting parameters for the current selection to 
be edited.  For more information on the cutting parameters, please refer to the machines 
Operator’s manual.  

Default Props – This button allows the default part properties that are applied to new parts to 
be edited.  Pressing this button will display the following dialog: 

 

Select the Material/Process combination to be edited and click on the underlined label. The 
following dialog will be displayed: 
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For more information on the settings in this dialog, see the Converting a CAD File section. 

 

Library File Path 

(CL-400, CL-800, CL-900, CL-707, CL7A-PC and CL-6 160i) This defines the path where the 
material library files exist.  This may be different for different configurations. 

Parameter Library Data File 

(CL-6 and CL-7A) This defines the data file where the parameter library data resides.  This 
file is the same format as the file created on a CL-6 or CL-7A Laser System with the macro 
executor option.  This file can be copied to/from the Laser System to ensure that material 
parameters are consistent between the Laser Programming and Nesting Software and the 
Laser System. 

Feedrate 

This setting determines how feedrates are posted in the output CNC file.  If "Explicit F xxxxx" 
is selected, then feedrates are added as explicit values, for example F200.  If "F #148 set in 
program" is selected, then a variable assignment statement, #148 = 200, is made near the 
top of the program and feedrates are added using a variable, F#148.  The last selection  
"F#148 set at machine" is similar to "F #148 set in program" except that no variable 
assignment is made at the top of the program.  This option is used with machines that are 
using the macro executor or library file to set value of variable #148 when the program is run. 

Use Percentages for Arc Feedrates 

This checkbox is only visible if the Feedrate selection above is set to “F #148 set in program” 
or “F #148 set at machine”.  If this is checked and an arc is slowed down to maintain the arc 
tolerance, the feedrate will be posted as a percentage of the process feedrate.  For example: 
“F [#148*0.25]”. 

Use Variables for Arc Feedrates 

This checkbox is only visible if the Feedrate selection above is set to “F #148 set in program” 
or “F #148 set at machine”.  If this is checked, all arcs that meet the criteria in the table will 
have their feedrates posted using variables instead of hard code values.  All arcs with a 
radius <= 0.125” will use F #123 as the feedrate, arcs with radius <= 0.750” will use F #124, 
and arcs with radius <= 4.500” will F #125.  The variables are defined at the beginning of the 
program and initialized to the minimum value for each range. 

Process Names 

Contouring paths are associated with process types in the Part Edit Window.  The 12 
different process names can be edited here. 

G89 Line 

Different laser power, assist gas pressure, and other machine control parameters are 
commanded by the CNC program for each process using G89.  This setting determines how 
G89 lines are added to the program.  

CL-707 and CL-6 160i:  The first selection, "Use P argument", causes a G89 P libname.lib to 
be inserted into the program whenever the process type changes (where libname.lib 
represents whichever library file is defined in the material list for the current material and 
process type). 

CL-6 and CL-7A:  The first selection, "Use X argument", causes a G89 X  nn to be inserted 
into the program whenever the process type changes (where nn is an integer from 1 to 100 
which  is defined in the material list for the current material and process type).  This option is 
only available if the Macro Executor option is selected. 
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The last selection "Use explicit parameters" causes G89, G102 and G103 lines with individual 
arguments to be output in the CNC program.  The values of all the arguments are defined in 
whichever parameter library file is assigned to the appropriate material and process type in 
the material list. 

Kerf Compensation 

This setting affects how kerf compensation is added to a program.  The kerf width itself is 
defined in the material library file that corresponds to the current material and process type.  
If the “Use kerf compensation" checkbox is selected, then G40, G41, and G42 commands are 
added as needed so that the machine control applies the correct kerf compensation.  If this 
checkbox is not checked,  no kerf compensation G Codes will be included. 

Post Kerf variable before each feature 

If this option is turned on, variable #200 is used to store the kerf width (system variable 
#2000) after each G89 line.  Then before each feature, the following line is inserted in the NC 
code: 

#2000 = #200 

This can be used to slightly adjust the size of features to maintain accuracy.  For example to 
make a certain hole diameter 0.002” smaller, edit the line before the hole to: 

#2000 = #200 + 0.002 
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Production Report 

 

  Production Report Configuration Page 

This page allows the user to configure the production report that is generated whenever a NC 
file is created.   

Report style 

This combo box has 5 settings: 

Don’t create report – If this setting is selected, no report file will be created. 

Plain text file – With this setting, a plain text report file is created with the file extension “.rpt”.  
The checkboxes in the Plain Text Reports section are used to control what data is included in 
the report file.  If an item is selected (checked), that item will be included in the production 
report.  The bottom 4 entries are for customer defined text fields such as company name, 
programmers name, etc.  If no items are selected, then a production report will not be 
generated. 
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XML Report file – If this setting is selected, the report data will be written out as an XML file 
with the extension “.report.xml”.   This setting gives the user the most control over the 
formatting of the data and also makes it easy to import the production data into other 
software.   The formatting of the data is controlled by the XSLT style sheet setting.  Several 
XSLT styles are provided and users with XSL background can modify these or create their 
own.   The provided styles include both a detailed style sheet (Detailed.xsl) with all 
information and a short summary style sheet (Simple_Summary.xsl).  NOTE: You must have 
Microsoft Internet Explorer 5.5 or greater installed to use the XSLT style sheets.   

CSV file – This setting is very similar to the Plain text file except that each field is separated 
by a comma (CSV: Comma Separated Values).  The file will be saved with a “.csv” extension.  
This file type can be useful to import the report data into a spreadsheet or other application. 

PDF file – This setting will create a PDF version of the report.  This PDF file will include 
pictures of the parts and pictures of the nest layouts.   Note: Adobe Reader or some other 
PDF viewer software will need to be installed on your computer to view the PDF files.     

 

Report file directory 

This allows the user to control which directory the report file is created in.  The default value 
is to store the report file in the same directory that the NC file is created in.  The other choice 
is to store all report files in a fixed location, regardless of the NC file directory. 

 

Sample Reports 
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   Sample Plain Text Report File 
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   Sample XML Report file  
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   Sample PDF Report file 
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Common Posting Options - 1 

 

  Common Posting Options Page 1 

Coordinate System 

These settings determine whether incremental mode (G91) or absolute mode (G90)  is used 
for the output CNC program.  If  "Part subprograms" is not selected in the Program Structure 
section, the "Within Part Subprograms" selections will be disabled. 

If the G92 option is selected between parts, the work coordinate system is commanded at the 
start of the program with G92 X#5021 Y#5022. This work coordinate system is the same as 
the machine. 

If the G91 option is selected between parts, the main program begins by raising the Z axis 
and moving the cutting head to machine X0 Y0 (with G53) before commanding G91 
incremental mode. 

If the G52 option is selected within parts, each part commands a "local" coordinate system 
with G52 X__ Y__, where X__ and Y__ are its starting location in the sheet coordinate 
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system.  The code for each part ends with G52 X0 Y0, which restores the sheet coordinate 
system for the move to the next part. 

Pallet Exchange 

These settings determine when pallet exchange codes (M50's) are inserted into the output 
CNC program.  If "Begin main program…" and "Begin each sheet…" are both selected, only 
one M50 is commanded before the first sheet.  Similarly, if both "End main program…" and 
"End each sheet…" are selected, only one M50 is commanded after the last sheet.  

Posted Units 

This setting determines whether the posted CNC program is output in inch units (G20) or 
metric units (G21).  This setting is independent of the View Units menu command. 

Posted Accuracy 

This setting determines whether the posted CNC program is output with a maximum of 3 
digits after the decimal point (2 in metric) or 4 digits after the decimal point (3 in metric). 

Z Axis 

M47 is the command for partial Z axis raise.  The distance is determined by a timer in the CL-
6 and CL-7A machine control and by a configuration parameter in the CL-707 machine 
control.  The M47 raise distance can also be commanded in a CL-707 program with M47 
P___ (See CL-707 Posting Options page). 

 

The post processor can be configured to output M47 in one of four ways, selected 
independently for Interior and Exterior paths: 

        No M47 

        All M47 with block delete (/M47) 

        All M47 

        Auto M47 (M47 is commanded only if the next rapid move intersects a cut path, 
 otherwise a /M47 is commanded.) 

Always use M47 if move distance is greater than XXXX  in.  – This checkbox controls 
automatic insertion of M47 when a move between paths exceeds a specified distance.  This 
override function commands M47 without block delete.   

Ignore head raise penalty when sequencing – When determining the cutting sequence for a 
nest, the software tries to minimize the number of head raises needed between parts.   This 
can result in cutting sequence that doesn't exactly match the specifications given on the Cut 
Sequence page of the nest file.  If this checkbox is checked, this optimization will not be 
performed which may result in a more uniform cutting sequence although the processing time 
for the sheet may be slightly greater. 

Program Structure 

If "Sheet Subprograms" is checked, the main program calls a subprogram for each sheet.  
Sheet subprogram numbers start at 100.   

The “One file per sheet” can be used with Sheet Subprograms to generate a separate file for 
each sheet in the nest.  The filenames used for each file will be the CNC filename with a 
“Sxx” extension where xx represents the sheet number.   For example,  “DemoNst_S01.cnc’ 
is the first sheet for the DemoNst nest.  This option is most often used with an automated 
Material Handling system. 
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If "Part Subprograms" is checked, a subprogram is created for each part.  Part subprogram 
numbers start at 1000.  If this is not checked, the program code for each occurrence of a part 
is included independently in each sheet program. 

The “Grid Macro” selection determines whether the NC code is posted using the 
CINCINNATI grid macro or not.  If this option is selected, you can chose where part 
subprograms begin with the “Part subs begin at (Xmin, Ymin)” checkbox.  The default value 
(check box NOT checked) is to begin each part subroutine at the first pierce location on the 
part.  If this option is selected, each part subroutine will begin at the (Xmin, Ymin) location on 
the part.  This is slightly less efficient however it is easier to write grid macro programs 
manually at the machine when this is selected.  

Regardless of the status of these checkboxes, the main program, any sheet subprograms 
and any part subprograms are all output in the same CNC program file. 

Sheet Order 

These option buttons control the order in which multiple sheets are processed in the main NC 
program.  If the "Custom Sheet Order" checkbox is checked, the software will sort all the 
sheets in nest based on the criteria specified and output the NC code in the sorted order.  
This can help the operator coordinate the time to remove parts and load a new sheet while 
another sheet is being cut.   

Return Head After Each Sheet 

If this option is selected, a rapid move to the specified X,Y position will be added at the end of 
each sheet in the nest.  This can be used to return the cutting head to the home position (0.0, 
0.0) or any other position after each sheet. 
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Common Posting Options - 2 

 

    Common Posting Options Page 2  

Program Comments 

These selections control the addition of comments to the output CNC program.  Comments 
can make reading and editing the CNC program easier however they do make it somewhat 
larger.  The last 3 selections are for user defined comments such as company name or any 
special instructions that may be required. 

Optical Probe 

The “Optical probe installed” checkbox is used to tell the Laser Programming and Nesting 
Software that the optional Optical Probe is installed on the CINCINNATI Laser System.   This 
option is available on the CL-707, CL-7A PC, and the CL6-160i.    Pressing the Settings 
button will display the following dialog: 
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If the “Align to holes” option is checked, the align to holes macro call (G65 P9730) will be 
added at the beginning of each sheet in the nest.  The “Probe calibration” option adds one 
calibration call (G65 P9720) at the beginning of the program. 

Note:  The optical probe options are only enabled if the following conditions are true: 

- Coordinate System Between Parts is not set to “Absolute (G90) with machine coordinate 
system (G53)”. 

- If part subroutines are enabled in the Program Structure section, the Coordinate System 
within Part Subroutines must be set to Incremental (G91). 

- The “Grid Macro” option must not be selected in the Program Structure section. 

If all of these conditions are not met, optical probe calls cannot be used. 

Nozzle to Probe Distance (#524): This value is used to graphically display the location of the 
nozzle in relationship to the probe holes to help insure that the nozzle is located over material 
while the align to holes macro is run.  The default value is 6.98" for the CL-707 and CL-7A PC 
and 5.60" for the CL-6. 

Rotate Sheet – The rotate sheet checkbox is enabled when the “Locate sheet at Xmax,Ymax” 
option is on.  When this box is checked, the X0 and Y0 edges of the sheet will be located 
along the Xmax and Ymax edges of the machine. 

Edge Detection Macro Calls 

If this option is selected, Edge Detection macro calls (G65 P9712…) are inserted at the 
beginning of each sheet program.  The Arguments button will display the following dialog: 
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The macro is called with the X argument equal to the X axis length specified in the nesting 
parameters for each sheet and the Y argument equal to the Y axis width of the sheet  The X 
axis length for a remnant sheet is interpreted as Xmax - Xmin from the remnant CAD data.  
Remnants are assumed to be loaded on the pallet with a straight edge along the machine X 
axis direction.  The other arguments are optional and will only be output if they are non-zero.  
Please consult the Programming manual for your specific laser for information on these 
arguments 

If the Edge Detection Calibration checkbox is checked, then the calibration macro (G65 
P9700 A__ B__ …) will be called at the beginning of the main program.  

Note:  The edge detection macro options are only enabled if the following  conditions are 
true: 

- Coordinate System Between Parts is not set to “Absolute (G90) with machine coordinate 
system (G53)”. 

- If part subroutines are enabled in the Program Structure section, the Coordinate System 
within Part Subroutines must be set to Incremental (G91). 

- The “Grid Macro” option must not be selected in the Program Structure section. 

If all of these conditions are not met, Edge Detection Macro calls cannot be used. 

Edge Detection with Optical Probe – If the optional Optical Probe is installed , edge 
detection works slightly differently.  The edge detection macro 9725 is called instead of 9712 
and calibration is done using the optical probe calibration macro instead of the edge detection 
calibration macro.  The edge detection and optical probe “Align to holes” functions are 
mutually exclusive, only one can be used at a time. 

Lower Pallet Special Function 

This option is only useful if the laser is equipped with the Lower Pallet Special Function 
option.  If this option is selected, the NC program will contain an M43 before the first move.  
The program does not end with an M44.   

The edit box displays the maximum machine Y axis coordinate to be used during M43 mode.  
Parts are only nested with maximum Y axis machine coordinates less than or equal to this 
amount. 

Line Numbers 

If this option is selected, line numbers are added to the CNC program before each rapid 
move.  A GOTO 1 statement is added before the first line number.  This GOTO statement 
can be edited at the machine control to make restarting a program in the middle very easy. 

Variable for Dwell after M67 
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One of the part editing options is placing a dwell after a M67 (see Optional Gas).  If this 
option is selected, dwells will be posted using the specified variable, for example:  G04 
P#117.  The variable will be initialized near the top of the main program.  This option allows 
the operator to change the dwell value at the machine in one convenient location without 
having to repost the NC code.  

Variable for Lead In Feedrate 

If this option is selected, the feedrate for lead ins will be posted using the specified variable 
(default 126).  This allows the lead in feedrate to be changed at the machine much easier.  

Locate sheet at Xmax, Ymax 

Most CINCINNATI laser systems have material stops located on the X0 edge and Y0 edge of 
the machine so by default, sheets are located at the X0,Y0 corner.  Some machines however,  
may have these stops located the Xmax, Ymax corner of the machine.  This option should be 
turned on for those machines so that sheets are placed in the Xmax, Ymax corner. 

Slat Saver 

When a nest is cut several times on the same laser, the slat tips can be worn by cutting all 
parts at the same location.  The Slat Saver option can increase slat life by cutting each nest 
with the parts at a slightly different location.  If this option is selected and a nest contains 
repeated layouts, separate NC code will be generated for each instance of the layout, each 
offset from the previous instance by a small amount.  The amount of offset is calculated by 
taking the space available between the sheet boundaries and the closest part to that 
boundary and dividing it between the repeated sheets.  The Maximum Offset parameter 
determines the largest offset that will be applied a sheet.      

Custom Code 

Pressing the Custom Code button will display the following dialog: 

 

This dialog is used to add user defined NC code to various locations in the NC programs.  To 
add NC code to program, check the appropriate checkbox and enter the code in the edit box.  
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For example, the settings above will add a comment and an M42 at the beginning of all 
programs and a M01 at the end of each part.   The code is inserted exactly as entered; it is 
the user’s responsibility to make sure that the text entered is valid NC code.  

DPRNT Options 

The CNC program can include DPRNT commands to output ASCII text strings to the RS-232 
port.  These can be used by the customer to externally record events during program 
execution.  This function requires the purchase of a control option on all models.    

 

Posting Options CL-707, CL-7A PC, CL-800, CL-900, CL-
400 

 
 Posting Options for CL-800, CL-707 and CL-7A PC 

This page contains posting options that are unique for the CL-800, CL-900, C-400, CL-707 
and the CL-7A PC. 
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Partial Z-up Distance 

This option determines whether partial Z-up commands use the machine default distance 
defined in the laser control's configuration  (M47) or use a user-defined value (M47 P___).  
Head crashes may result if the partial Z-up distance is set lower than the recommended 
minimum of 0.750 in. (19mm.). 

Sheet cutoff partial Z-up distance- This value controls how much the head will be raised after 
each sheet cutoff.  A M47 Pxxx command will be inserted after each sheet cutoff move.  
Setting this value to 0.00 will result in just a M47 command being used and the Z-up distance 
will be determined by the machine default value. 

Smart Rapids 

The CNC program begins with G121 when this box is checked.  In G121 mode, the laser 
control replaces G00 rapid moves between paths with "Smart Rapid" moves.  Smart Rapids 
command the beam off and on without stopping the machine axes.  For more information on 
smart rapids, see the Smart Rapid section of the part editing window. 

Misc Options 

Fast Pack Machine – This option is used to identify a new higher performance “Fast Pack” 
CL-707 from an older CL-707.   

Rapid Pierce – This should be turned on if your laser system has the Rapid Pierce option.  If 
this is enabled, you can program a G84 T2 for the start of cut in the Start Cut page 

Optional Standoff (M45) – This option is used to post NC code on older CL-707’s that do not 
support the M45 m-code.  If this checkbox is not checked, M45’s will not be posted in the NC 
code even if the part file has Optional Standoffs programmed. 

Alternate Machine Coordinate System (G153) – This option is used to post a G153 code at 
the beginning of the program to tell the Laser system to use the Alternate Machine 
Coordinate System. 

Micro Weld – This option should only be turned on if the Laser System is equipped the micro 
weld option. 

Use Gas Names – If this is turned on, the Process Library files will display gas names instead 
of Port 1 and Port 2. 

Process monitor – This option should only be turned on if the Laser System is equipped with 
the Process Monitor option.  This allows the Adaptive Pierce mode to be selected in the 
process library files. 

Pierce Only Codes – If this option is selected, special pierce only G codes will be used when 
the Complete all Pierces Before Cutting option is used. This should only be turned on if the 
Laser System can handle G84 T4 and G84 T5 codes (CNC Software version 8.0 or greater). 

Vision System – This option should be turned on if the Laser System is equipped with the 
Vision System option with the Cognex camera.  For more information, see the Vision System 
part editing function. 

Speed Gas 

Processing paths end with M135 instead of M35 when this option is selected, causing the 
assist gas valve to remain open between paths.  This can be overridden on long moves by 
using the Speed Gas Override function.  
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Posting Options CL-7A 

 

 Posting Options for CL-7A 

 

This page contains posting options that are unique for the CL-7A. 

Misc Options 

Macro Executor - This option should be selected if the target CL-7A Laser System is 
equipped with the macro executor option.  This must be selected for the "Auto Restart" and 
the "G89 X" options to be available. 

Auto Restart - If this option is selected, each G84 block has a unique line number and the 
S#4114 argument in the block.  These line numbers are in addition to any selected I the 
Common Post Options screen.  The main program also commands M96 P9990 before the 
first G84. 
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Look Ahead Control - If checked, the CNC program begins with "G08 P1" and ends with 
"G08 P0".  Changing this value also changes the Feedrate Constant used to calculate the 
feedrates for arcs.   

Post G102 commands – This determines whether or not G102 commands are included in 
the NC output.   

Rapid Pierce - This should be turned on if your CL-7A has the Rapid Pierce option.  If this is 
enabled, you can program a G84 T2 for the start of cut in the Start Cut page.   

Three assist gases – This option is used to post code for older CL-5 and CL-7 laser systems 
that supported 3 assist gases.   

 

Touch Probe 

If these options are selected, G107 and G106 macro calls are added to the beginning of the 
CNC program.  

M25 Option 

When this box is checked, the software commands M25 instead of G84 where permitted.  
M25 can only be used when the processing parameters have no pierce time and no pre-cut 
dwell.  In addition, G84 will be used for any path that follows a M47 or M42 (with or without 
block delete). 
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Posting Options CL-6 

 

  Posting Options for CL-6 

 

This page contains posting options that are unique for the CL-6. 

Misc Options 

Macro Executor - This option should be selected if the target CL-6 Laser System is 
equipped with the macro executor option.  This must be selected for the "Auto Restart" and 
the "G89 X" options to be available. 

Auto Restart - If this option is selected, each G84 block has a unique line number and the 
S#4114 argument in the block.  These line numbers are in addition to any selected I the 
Common Post Options screen.  The main program also commands M96 P9990 before the 
first G84. 
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Look Ahead Control - If checked, the CNC program begins with "G08 P1" and ends with 
"G08 P0".  Changing this value also changes the Feedrate Constant used to calculate the 
feedrates for arcs.   

 Rapid Pierce - This should be turned on if your CL-6 has the Rapid Pierce option.  If this is 
enabled, you can program a G84 T2 for the start of cut in the Start Cut page. 

Use M100 as Part Counter – This option is only available with the 160i control.  If this option 
is turned on, a M100 will be posted at the end of each part in the nest.  The M100 causes the 
part counter on the Fanuc control to increment.   

Initialize auxiliary cutting variables.  – (CL6-160i only) If this option is turned on, the 
variables used for auxiliary cutting, #136, #142, #143, and #144 will be initialized before 
every G89 line.   

M25 Option 

When this box is checked, the software commands M25 instead of G84 where permitted.  
M25 can only be used when the processing parameters have no pierce time and no pre-cut 
dwell.  In addition, G84 will be used for any path that follows a M47 or M42 (with or without 
block delete). 

Pierce on the Fly 

This option uses the pierce on the fly capabilities of the CL-6 Laser System.  Pierce on the fly 
replaces the beam off command (M35), rapid traverse move (G00), and beam on command 
(G84 or M25) between two features with a single linear move (G01) at the specified feedrate 
and zero laser power.  This can greatly reduce cycle times for certain parts.   

Several conditions must exist before pierce on the fly will be used even if the option is 
selected. They are: 

- No pierce time or pre-cut dwell must be used. 

- No optional gas pressure can be used. 

- The head must remain down between moves.  To ensure this, the "Z Axis" options on the 
"Common Posting Options - 1" page must be set to either No M47 or Automatic M47. 

Important Note:   Programming G1 with S0 to leave the beam on between cuts will expose 
the material to minimum laser power at the same focal position used for cutting.  The material 
surface may be etched during the move.    

Speed Gas 

This option is only available if the CL-6 is equipped with the 160i control.  Processing paths 
end with M135 instead of M35 when this option is selected, causing the assist gas valve to 
remain open between paths.  This can be overridden on long moves between internal 
features by using the Speed Gas Override function. If the move distance between internal 
features is greater than the override distance, a M35 (beam and gas off) will be posted even 
if the M135 option is selected. 
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Time Study Parameters 

 

   Time Study Parameters 

These values are used to configure the part processing time calculations.   The only values 
that may need to be modified are in the Machine Simulation section.  

Machine Simulation 

The speed gas selection simulates the Speed Gas menu item under the Variables menu on 
the CL-707 control.  Turning this on make all M35's in a program behave as if they were 
M135's. 

The block delete selection simulates the block delete button on the machine control.  If this is 
on, then the part processing time calculations assume that the block delete button will be 
active on the machine control when the program is run and skips any lines that have a block 
delete in front of them. 
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Preferences 

 

 

This page is used to configure various user preferences of the software.  

Use same directory for CAD, part, nest and NC files 

When this option is off (default), the software remembers where each different file type is 
stored and defaults to that directory when a new file is created.  For example CAD files can 
be stored in a DXF directory, parts can be stored in a PART directory, nest files can be stored 
in a NEST directory, etc.  

Some users, job shops for example, prefer to keep all of the files for a particular job together.  
Turning this option on does that.   When a part file is created, it will be stored in the same 
directory that the original DXF file was.  Nest files and NC files will also default to the same 
directory until it is changed.   

Ignore outline lead in when nesting 
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If this option is selected, the lead in and lead out of the outline of a part will be ignored when 
the part is nested.  This can sometimes yield more efficient nests as shown below: 

   

Regardless of this setting, the outline lead in will not be ignored if the lead in length is greater 
than the part spacing value or if Common Line cutting is enabled for the part. 

Ignore lead in when calculating part size 

If this option is checked, the displayed part size will not include the outline lead in. 

Convert splines and ellipses to arcs 

If this option is turned on, all splines and ellipses in DWG and DXF files will be approximated 
with a series of circular arcs when the file is opened.  The conversion accuracy value 
determines how close the approximation is to the original geometry.  If this option is not 
turned on, splines and ellipses will be ignored in the drawing file.   

Interface with CINCINNATI MMHS 

This option should be turned on when posting files that will be used with the CINCINNATI 
Modular Material Handling System.  This option will also turn on the Sheet Subprograms 
and One file per sheet option on Common Posting Options Page 1.  This will also cause a 
task file to be created for the nest that can be added directly into the CINCINNATI Modular 
Material Handling System. 

Ignore cutter compensation when plotting NC code 

If this option is turned on, when NC code is plotted, cutter compensation will not be applied to 
the moves.  This allows the displayed coordinates on the screen to exactly match the 
coordinates listed in the NC code.  This can make debugging NC code simpler.   

Use G85 (or G84 T3) for etched features 

If this option is turned on, etched features will begin with a G85 (or G84 T3) instead of a 
normal G84 call.   

Sort part editing functions 

When this is checked, the part editing combo box will be sorted alphabetically.  Users can 
turn this off if they are more familiar with the order of the combo box in previous versions of 
the software.   

Ignore text entities in CAD files 
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If this is checked, all text entities in CAD files will be ignored.  This can speed up loading of 
CAD files that contain a very large amount of text.   

Use alternate nest view printing method 

This may be necessary when printing to some printers if the small part picture is not printed 
with the nest layout.   

Display order number column 

This option is used to determine whether or not the “Order #” column is displayed on the nest 
part list page. 

Check for overlapping parts before generating NC code 

If this option is checked, the nest will be checked for overlapping parts before NC code is 
generated.   If overlapping parts are detected, the user will be warned and they can stop and 
correct the problem or ignore the warning and continue with the NC code generation. 

Append date/time to default filenames 

If this option is checked, the default nest name will contain the current date and time.  The 
name will be NestMMDDYY_HHMMSS instead of Nest1, Nest2, etc.    

Remember print orientation for each file type 

If this option is checked, the print orientation (portrait vs. landscape) is remembered for each 
file type.      

Determine inch/metric from drawing extents 

If this option is checked, the software will try and determine what the inch/metric setting 
should be for a drawing file.   To do this, it looks at the X extents of the drawing file, if it 
greater than the X travel limits of the machine, it assumes the drawing is in metric, otherwise 
it is in inch.   

Material Utilization Calculations 

Use true area of parts:  The material utilization is calculated by dividing the sum of the 
actual surface areas of the nested parts by the surface area of the sheet.  The actual surface 
area of the part is the area of the outline minus the area of all internal cutouts.   

Ignore area of internal features:  The material utilization will be calculated by dividing the 
sum of the areas of the outlines of all the nested parts by the surface area of the sheet, the 
area of the internal cutouts of all parts is ignored.  Note, if this option is used and part in slug 
nesting is enabled, it may be possible to generate a nest with greater than 100% material 
utilization. 

Use simple rectangular area of parts: With this method, the area of each part is calculated 
by multiplying the X extents of the part by the Y extents.  

Include sheet boundaries in calculations:  If this is checked, sheet boundaries and clamp 
zones will be included in the utilization calculations.  The default value is unchecked, 
meaning that the area used by sheet boundaries and clamp zones is ignored. 

Feature Avoidance Parameters 

Minimum Hole Area - If a feature’s area is less than this value, the Feature Avoidance 
software will allow the cutting head to move over the feature after it has been cut out.  The 
default value is .063 sq. in.  Caution: Increasing this value may result in head crashes. 

Buffer Zone – When this value is set to 0.0” (the default), the feature avoidance software will 
only raise the cutting head if the ideal straight line rapid path between two features crosses a 
previously cut feature.  This is normally acceptable however occasionally it may be desirable 
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to define a safety or buffer zone around the rapid path.    If a buffer zone value is 
programmed, any previously cut feature within this zone will cause the head to be raised.   In 
the picture below, the head will remain down if the buffer zone value is set to 0.0” but the 
head would be raised if the buffer zone was set to 0.50”. 

 

Number of Sections – This value determines how small of pieces the part will be divided into 
by the feature avoidance software.  Increasing the number of sections (maximum value is 
150) will make the software take longer to find a solution however the solution it finds may be 
more optimum than the solution found with a lesser number of sections. 

Process etched features first – If this option is checked,  all etched features will be 
sequenced before any other non-etched features. 

Preferred Lead In Location – This setting can be used to restrict where the lead in is placed 
by feature avoidance.  The location can be restricted to linear segments, circular segments or 
intersections.  The Automatic setting is for “no preference” and will result in the optimum 
results.  Setting a preferred lead in location may result in more rapid travel distance or more 
head raises. 

Play Sounds 

The software can be configured to play a sound after a time consuming task is completed 
(nesting, drawing conversion, CNC creation).    Any wav file can be used as the notification 
sound, this is configured by pressing the Settings button: 

 

Generic Posting Options - 1 
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This page is used to add user defined NC code to various locations in the NC programs. It is 
only visible when the Machine Type is set to “Generic Post”.   

Process 

Each Process type has its own settings for custom NC code.    

Generic Posting Options - 2 
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This page is used to set miscellaneous parameters of the generic post . It is only visible when 
the Machine Type is set to “Generic Post”.   

Posted Units 

This setting determines whether the posted CNC program is output in inch units (G20) or 
metric units (G21).  This setting is independent of the View Units menu command. 

Posted Accuracy 

This setting determines whether the posted CNC program is output with a maximum of 3 
digits after the decimal point (2 in metric) or 4 digits after the decimal point (3 in metric). 

Coordinate system 

This setting determines whether the NC code is posted in either Absolute coordinates (G90) 
or Incremental coordinates (G91) 

End of line 

This can be used to specify any special characters that need to be output at the end of each 
line of NC code 
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Line numbers 

If this checkbox is selected, line numbers (Nxxxx) will be output at the beginning of each line. 

Return head after each sheet 

This can be used to insert a rapid move to a certain location after each sheet. 

Apply kerf offset to part geometry 

If this checkbox is checked, all part geometry will be offset by the kerf offset value specified 
on the Process Parameters configuration page. 

   

Color Preferences 
The Color Preferences dialog is located under the View menu.  It is used to customize the 
colors used by the software. 

 

To change a color, first set the Item field to whichever screen or dialog that you would like to 
customize.  Then set the Foreground, Background and Option colors to the desired colors.  
The Apply button can be used to apply the selected colors to the current screen to check the 
appearance.  The Reset Defaults button will reset all of the colors back to the CINCINNATI 
default values. 
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Importing a CAD file 

Overview 
The CINCINNATI Laser Programming and Nesting software interfaces to other CAD software 
by reading DXF, DWG or IGES files.  Most CAD software packages can export drawings in 
one of these formats. 

The following rules exist when importing CAD files: 

1. The following entities are supported for DXF and DWG files: LINE, CIRCLE, ARC, 
POLYLINE, LW_POLYLINE, TEXT, MTEXT, BLOCK, and INSERT.  In addition, 
ELLIPSE and SPLINE entities can be approximated with a series of circular arcs. (see 
Preferences configuration page) 

2. IGES files are limited to Circular Arcs (type 100) and Line (type 110) entities.    

3. Dimensions are not imported and are not displayed. 

4. Multiple layers are supported. 

5. Line types and colors are ignored. 

6. DXF files should be ASCII formatted, not binary. 

 

The only method of editing CAD files within the CINCINNATI software is turning on/off entities 
or layers.  Features cannot be added and dimensions cannot be changed.  The user must 
use their CAD software to make modifications to the geometry   

 

 

Opening a CAD file 
To open a CAD file, select the Import CAD File menu item under the File menu or press the 

Import CAD icon on the toolbar:  
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 CAD Display Window 

Drawing Units 

This is used to tell the software whether the drawing was originally done in English units 
(inch) or Metric units (mm).  DXF and DWG files do not contain this information so you must 
make sure that this is set correctly.  The drawing extents, displayed in the status bar at the 
bottom of the window, can be helpful in determining whether a CAD file was drawn in English 
or Metric units. 

Display Text 

This can be used to turn off all text in the drawing.  This will be grayed out if the drawing 
doesn’t contain any text or text display has been disabled in the configuration. 

Display Endpoints 

If this option is checked, a small red square will be drawn at the start point and end point of 
each entity.  This feature can be useful to locate overlapping lines and gaps between lines. 

Drawing Layers 

If multiple layers are used in the drawing, they will be displayed in this list box.   To turn off a 
layer, click on the checkbox next to the layer name in the list box.  Clicking on the checkbox 
again will select it and turn it back on. 

Select All 
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This button can be used to select or unselect all entities in the drawing.  Pressing it once will 
select all entities, pressing it again will unselect all entities. 

Selecting Entities 

Individual entities can be turned off/on using one of the following methods: 

Entity - Use the mouse to click on an entity, if it is currently selected (displayed in yellow) it 
will be un-selected (displayed in brown), if it is currently un-selected, it will be selected. 

Window - The mouse is used to draw a window around entities.  Press and hold the left 
mouse button to start the window, drag the window to the desired size, and then release the 
left mouse button.  All entities inside of the window will have their selection status toggled.   

 

Converting a CAD File 
Once a CAD file has been opened and any unnecessary layers and entities have been turned 
off, the file can be converted into either a CINCINNATI part file or remnant file.  To do this, 
press the Convert button in the CAD file window.  

 
 CAD Convert Dialog 
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This dialog is divided in two sections. The upper section contains general conversion 
properties explained below.  The lower section contains default part properties that are based 
on the material and process combination selected.  These are detailed on the following 
pages.  

Output filename 

This is the name of the part or remnant file that will be created.  Part files must have a .PRT 
extension and remnant files must have a .SHT extension.  The Browse button can be used 
to change directories. 

Convert to 

This list box is used to choose between converting to a part or converting to a sheet remnant.  

Drawing Units 

This is used to tell the software whether the drawing was originally done in English units 
(inch) or Metric units (mm).   

Endpoint Tolerance 

If the distance between the endpoints of two CAD entities is less than this amount, the 
entities are considered connected.  If the distance is a gap, then the entities are extended to 
the intersection.  If the distance is an extension beyond an intersection, then the entities are 
trimmed back to the intersection. 

Allow Open Paths 

If this option is selected, open geometry will be converted into non closed features on the 
part.  If it is not selected, open geometry will be ignored.  Open geometry is a path that has at 
least one gap between endpoints that is larger than the endpoint tolerance.  

Join Broken Linear Segments 

If this option is selected, broken linear segments of the drawing will be reconnected when the 
drawing is converted.    

Feature Avoidance 

If Run Feature Avoidance is checked, the CINCINNATI Feature Avoidance software will be 
run on the CAD file when it is converted into a part.  The Feature Avoidance software is used 
to automatically sequence the part for head down operation.  

 If feature avoidance is not run at the time of conversion, it can be run later in the Sequence 
dialog in the Part window. 

Close drawing file after conversion 

If this option is selected, the CAD drawing file will be closed  after the drawing has been 
converted into a part file.  

Convert Text 

If this option is selected, text entities will be converted into text fields on the part.  This 
checkbox will not be visible if the drawing doesn’t contain text entities or the text has been 
turned off.  See the Converting Text section for more details. 

Material and Process 

This field is used to assign a material and default process to the part file when it is converted.  
It also initializes the remaining Default Part Properties to the same values that were used the 
last time a part was created with this combination.  Because of this, it is important that this 
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field be set correctly before any of the other part properties are changed.   Note: The default 
part properties can also be edited on the Process Parameters configuration page. 

 

General 

 

 General Part Properties 

 

This page contains general part properties and specifies the Drawing Layer <-> Process 
Type relationships. 

Grain direction 

This sets the grain direction of the part.  For more information, see the "General" menu of the 
part editing screen. 

Rotation angle 

This determines the rotation intervals that the nesting software will use to locate the part.  For 
more information, see the "General" menu of the part editing screen. 

Arc Tolerance 

This value is the default arc tolerance that will be used for the part.  The arc tolerance is used 
to calculate feedrates for the posted NC code.  This value can be changed later in the "Arc 
Tolerance" menu of the part editing screen. 

Allow Mirror Image, Auto Pair, Common Line 

These values will be assigned to the part after it is converted.  For more information on these 
values see the "General" dialog in the part editing section.  

Interior paths CCW, Exterior paths CCW 

These settings determine the cutting direction of interior and exterior paths.  The default 
value is counter-clockwise (CCW) for both.  

Layers 

This controls which cutting process is assigned to which layer when the drawing is converted.  
These can be changed at a later time using the “Process” dialog in the part editing window.  



 

48  ••••  Importing a CAD file Laser Programming and Nesting 

Setting the process to “Don’t convert” means that the entire layer will be ignored when 
converting.   

Setting the process for a layer to "Preprocessed" tells the software that the features on that 
layer have already been cut out before they reach the laser so they do not need to be cut 
again.  However, preprocessed features are not totally ignored.   They are still referenced by 
the feature avoidance software to ensure that the cutting head does not travel over them 
when the rest of the part is cut.  See Preprocessed Parts for more information. 

Advanced 

 

 Advanced Part Properties 

This page contains advanced cutting parameters that may be necessary when cutting certain 
materials. 

Corner Radius  

If this checkbox is checked, a corner radius will be added to every intersection that meets the 
criteria in the Properties window.  For more information, see the Corner Radius menu of the 
part editing screen. 

Exact Stop 

This can be used to add an exact stop on every corner that meets the criteria in the 
Properties window.  For more information, see the Exact Stop menu of the part editing 
screen. 

Ramped Start, Ramped End 

These checkboxes can be used to add ramped starts and/or ramped ends to all features of 
the new part.  For more information, see the Ramped Start/End menu of the part editing 
screen. 

Corner Ramping 

This checkbox is used to add a ramped corner at every corner on the new part that meets the 
criteria in the Properties window.  For more information, see the Corner Ramping menu of the 
part editing screen. 

Auto Tabbing 
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This can be used to add tabs to selective features of the new part.  For more information, see 
the Lead In/Out menu of the part editing screen. 

Corner Looping 

This checkbox is used to add corner loops on the exterior feature of the new part.  For more 
information on corner loops, see the Corner Loop menu of the part editing screen. 

Start of cut 

This listbox determines which type of pierce is used for all features in the new part.  For more 
information on the different pierce types, see the Start Cut menu of the part editing screen. 

End cut with M37 

If this option is checked, features will end with a M37 instead of the normal M35.  M37 is the 
same as a M35 except that the shutter is closed also. 

Z-Axis Servo Hold 

This checkbox is used to add a Z-Axis Servo Hold m code (either M36 or M38) after the 
pierce of all features on the new part. For more information, see the Z Axis Servo Hold menu 
of the part editing screen. 

Antidive disabled (M130) 

If this checkbox is checked, Z-axis antidive will be disabled for the entire part.  See the Z-Axis 
Antidive menu of the part editing screen for more information. 

Optional Gas 

This option is used to program a M67 (Optional Gas pressure) code and an optional dwell 
time after the lead-in of all features. For more information, see the Optional Gas menu of the 
part editing screen. 

Optional Standoff 

This checkbox is used to add a M45 (Optional Standoff) code after the lead-in of all features.   
For more information, see the Optional Z Standoff menu of the part editing screen. 

Dynamic Assist Gas 

This option is used to program a M68 (Dynamic Assist Gas On) code after the lead-in of all 
features.  For more information, see the Dynamic Assist Gas menu of the part editing screen. 

 

Lead In/Out 

The second page of the dialog allows lead-in and lead-out values to be assigned to the new 
part: 
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 LeadIn/Out Properties 

These values define the default lead in and lead out that will be used for all features and the 
outline of the part.  The lead in/out parameters can be edited later after the part is created 
using the Lead In/Out dialog in the part window 

Use same values for interior and exterior features - If this check box is checked, then the 
same lead ins and lead outs will be used for both the interior features and the outline of the 
part.  If it is not checked, then different values can be used for interior lead ins/outs and the 
outline lead in/out.  If it is not checked, the list box is used to determine which parameters are 
being edited, the "Interior features" or the "Exterior feature". 

Lead In 

The software supports two types of lead ins, simple one piece linear lead ins and "custom" 
lead ins.  Custom lead ins can be made up of multiple arcs or lines with varying feedrates and 
dwells.  For more information on custom lead ins, see the Custom Lead In file description. 

Custom Lead In - This checkbox determines which type of lead in will be added to the part, a 
custom lead in or a simple lead in.  If it is checked, a custom lead in will be used and the lead 
in section of the dialog will change to: 

 

Lead in name - This is the name of the custom lead in file that will be used for the part.  See 
the Custom Lead In File section for information on creating these files. 

Pressing the Browse button will display the Lead In File selection dialog: 
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Selecting a lead in file will display a preview of the lead in and also display the extents and 
any notes that have been entered for the lead in.  Press the OK button when the desired 
custom lead in file has been selected. 

 

If the Custom Lead In checkbox is not checked, then a simple linear lead in will be used.  The 
following parameters control the simple lead in. 

Length - This is the length of the lead in.  It should be set to 0.000 if no lead ins are desired.  
If the length of the lead in is greater than one half of the width of the feature, then the lead in 
will be shortened to this length.  For example, if a .100" lead in is programmed for a .120" 
diameter hole, the lead in will be shortened to .060". 

Angle - This is the angle the lead in makes with the first entity of the feature.  If this value is 
0° and the feature is an exterior feature, the lead-in will be placed at the beginning of line 
segment, otherwise the lead-in will be placed in the middle of a line segment. 
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Feedrate - This is the feedrate used for the lead in.  It can be entered as either an absolute 
value in inches/min (mm/min) or as a percentage of the process feedrate listed in the material 
list. 

Exact Stop - This determines whether or not an exact stop is used after the lead in. 

Lead Out 

The software also supports two types of lead outs, simple one piece linear lead outs and 
"custom" lead outs.  Custom lead outs can be made up of multiple arcs or lines with varying 
feedrates and dwells.  For more information on custom lead outs, see the Custom Lead Out 
file description. 

Custom Lead Out - This checkbox determines which type of lead out will be added to the 
part, a custom lead out or a simple lead out.  If it is checked, a custom lead out will be used 
and the lead out name will be displayed. 

Length - This is the length of the simple lead out.  It should be set to 0.000 if no lead outs are 
desired.   

A negative value for lead out can be used to create a tab on a part. This can be useful to 
prevent parts from tipping or to keep small parts from falling into the scrap tray.  In this case, 
the angle field is not used. 

Angle - This is the angle the simple lead out makes with the last entity of the feature. 
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Converting Text 

 

 

If the “Convert Text” checkbox is checked, all text that hasn’t been turned off in the drawing 
will be converted to text on the part.  Note, if the drawing doesn’t contain any text or all the 
text has been turned off, the “Convert Text” checkbox will not be visible. 

The cutting process used for the text is specified with the “Process” combo box.  This will 
normally be set to “Etch”. 

The font used for the converted text can be the same font as the original drawing by setting 
the “Font” combo box to “Don’t change font”.  This results in the most accurate representation 
of the original text, but the text cannot be edited later. 

Alternatively, the font can be changed to a different font by selecting it in the combobox.  The 
only alternative font supplied with the CINCINNATI software is called “SimpleFont” and is 
limited to the following characters: “1234567890ABCDEFGHIJKLMNOPQRSTUVWXYZ-
+=*[]_.()/\<>”.   
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Additional fonts can be created by the user.  For information regarding the font file format, 
refer to the Font File Definition section. 

  If the converted text contains characters that aren’t in the new font, they will be replaced 
with blank spaces.  The font height will be maintained but the actual width of the text may 
change slightly because of differences in the character widths between fonts. 

Important Note:  Although the text may look more visually appealing when the font is not 
changed, it may require the laser to take a significant amount of additional time to process 
the text.  Most fonts used in AutoCAD are outline type fonts and require a large number of 
entities to represent them.  Changing to the “SimpleFont” font can dramatically speed up the 
processing time for the part.  The differences between the “Simple” font and AutoCAD’s “Txt” 
font are shown below: 

 

 

Incrementing Part Numbers 
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If the imported text string consists only of question mark characters (‘?’), the text will be 
converted into a “Incrementing part number” field.  The length of the incrementing part 
number will be the number of question mark characters.  For example the string, “????” 
would be converted into a 4 digit incrementing part number.  For more information on 
incrementing part numbers, see the “Text” part editing section. 

Batch Conversion 
The CINCINNATI Laser Programming and Nesting software has the ability to convert a group 
or batch of CAD files into part files at one time.   

To do a batch conversion, use the Import Cad function as if you were opening a single DXF 
file.  Instead of selecting one file and pressing OK, select all the files to be converted using 
the standard Windows techniques for multiple file selection (using the Shift or Control key 
while clicking or dragging a window around files) as shown below: 
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Once all the files have been selected press the OK button.  The Batch convert dialog will be 
displayed.  This is almost identical to the normal Cad convert dialog with a few exceptions: 

 

Output path 

This is the path that all of the part files will be written to.  All filenames will be the name of the 
CAD file with a PRT extension. 

Layers 

Ignoring CAD entities in batch mode is done on a layer by layer basis.  There are two ways 
that layers can be specified.  The first is that individual layer names can be added to the list 
box and a process assigned to each layer.  Setting the process to “Don’t convert” means that 
any entities on that layer will be ignored when the drawing is converted.  The Insert and 
Delete buttons can be used to add and remove layer names from the list box. 

The second method is the “All other layers” field.  Any layer in a drawing that is not 
specifically listed in the list box falls into this category and will be assigned the process 
specified in the “All other layers” combo box. 

Parts without Outlines 
Almost every part has an outline that encloses all of the interior features.  Occasionally 
however, it may be necessary to create a part that does not have an outline, for example if 



 

Laser Programming and Nesting Importing a CAD file  ••••  57 

the outline of the part has already been cut by some other process and only  the interior 
features will be cut on the laser.  This can be accomplished by creating a part without an 
outline. 

To create a part without an outline, either start with a CAD file that does not have the outline 
drawn or turn off all of the outline entities.  When the Convert button is pressed, the following 
warning message will be displayed. 

   

Press “Yes” to continue creating the part.  

IMPORTANT NOTE: Parts without outlines cannot be automatically nested.  If a part without 
an outline is added to a nest, a warning will be displayed when the create nest button is 
pressed, stating that parts without outlines will not be nested.  However, you can add the 
parts to the nest layout manually afterwards.  See the manual nest editing section for more 
details. 

Preprocessed Parts 
When a customer has a punch press and a laser-cutting system, sometimes the most 
efficient way to produce a nest of parts is to first punch some of the openings and then finish 
cutting the parts with the laser.  Using the following procedure, the CINCINNATI software can 
create a NC program for the laser cut portion of a preprocessed sheet. 

IMPORTANT NOTE: Parts with preprocessed features can be added to a Grid Nest, but they 
cannot be automatically nested in a Normal Nest.  If a part with preprocessed features is 
added to a normal nest, a warning will be displayed when the create nest button is pressed, 
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stating that these parts will not be nested.  However, you can add the parts to the nest layout 
manually afterwards.  See the manual nest editing section for more details.  

CAD File 

The first step to creating a preprocessed part begins with the CAD file.  Preprocessed 
features and laser cut features must be separated on different drawing layers.  There can be 
multiple preprocessed layers and/or multiple laser cut layers but an individual layer cannot 
contain both preprocessed features and laser cut features.  In addition, the sheet outline can 
be included either on it's own layer or on one of the preprocessed layers.  The following is an 
example of a preprocessed drawing: 

 

Creating the Part 

The next special step occurs when the Convert button is pressed and the normal CAD 
Convert dialog is displayed.   The process for all preprocessed layers must be set to 
"Preprocessed". 
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The remaining fields on the CAD convert dialog should be filled in as normal. 

NOTE:  If the "Use Feature Avoidance" checkbox is checked, feature avoidance will be run 
separately on each part that the software locates in the drawing file and one additional time 
for the overall sheet. 

Editing the Part 

If the part file is created successfully, the part file will be opened. 

 

The preprocessed features are displayed using a dashed gray line to differentiate them from 
the laser cut features.  

The Allow Mirror Image, Auto Pair, Common Line, Rotation Angle, and Grain Direction 
fields are all disabled for preprocessed parts.   All other types of part editing (Exact Stops, 
Corner Ramping, etc.) can be preformed.   The CINCINNATI software attempts to determine 
which features are inside cuts and which are outside cuts when the part is created, however it 
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may not always come up with the desired result.  This can be viewed/changed in the Part 
Sequencing window.  

Creating NC Code 

Once the Preprocessed part has been created, the next step is to create NC code.  There are 
two options for doing this, creating a single part NC file or creating a Grid Nest.   

Single Part NC  - This is the easiest method and is done the same way NC code is created 
for a normal part.   Just press the "Create NC" button on the General part editing window.  If 
the Optical Probe is being used to locate the sheet, a hole verification dialog will be 
displayed. 

 

Grid Nest - The Grid Nest is more complicated but has the advantage of being able to add 
sheet cutoffs and adding other parts to the sheet.  Grid nesting is covered in a separate 
section. 

 

Shape Library 

Shape Library 
The Shape Library can be used to quickly create part files without starting with a drawing file.  
To open the Shape Library, select the Shape Library option under the File menu or press 

the Shape Library icon on the toolbar:   

 

The shape library dialog is shown below: 
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The left side of the dialog shows the different shapes available.  Once the desired shape is 
selected, the dimensions of the shape can be changed in the center of the dialog.   When the 
dimensions are correct, the user should select the Material and Process and then press the 
Create Part button.  The part will be created and displayed: 
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Laser Programming and Nesting Software  Part Files  ••••  63 

Part Files 

Overview 
The CINCINNATI Laser Programming and Nesting software stores parts as files with the 
.PRT extension.  To edit a part, use the File Open Dialog and select the appropriate .PRT file.  
When the file is opened, the following window will be shown: 

 

The bottom of the window displays the part.  The  display can be zoomed by using any of the 
zoom tool bar buttons or selecting a zoom option under the View menu.    
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The dialog box at the top of the window allows various parameters of the part to be edited.  
The list box in the upper left corner of the dialog box selects which dialog is shown.  The 
following pages explain the various dialog boxes. 

General 

 

CAD file  

This displays the name of the DXF or IGES file that was used to create this part.  If the cad 
file is changed after the part has been created, the Re-Convert button will be enabled.  
Pressing this button will open the cad file so it can be re-converted if desired.  Note:  Re-
converting the cad file will reset any modifications that have been made to the part file. 

Create NC  

This button can be used to create a single part NC file.  The part will be located at the 
machine (0.0, 0.0) position unless the part has a precut edge defined or has machine 
coordinates defined. 

Allow Mirror Image  

If selected, allows a mirror image of the part to be nested.  This option can improve nesting 
efficiency for non-symmetrical parts. Note: By selecting this option, the user acknowledges 
that all versions of this part may not have the same relationship between the 2D shape and 
the "top" and "bottom" of the laser-cut edge.  For example, this option should not be used for 
parts made from stainless steel coated with plastic on only one side or thick material where a 
different edge taper direction may not be acceptable.  

Auto Pair  

If selected, the part is nested first with itself then the pair of parts is nested on the sheet.  
Individual parts are nested only after pairs cannot be nested. 

Common Line 

If selected, the part is considered for common line cutting with other parts having this 
selection or other copies of the same part.  Only straight line edges are considered for 
common line cutting.  See Common Line in the "Nest Layout" section for more information.  

Rotation Angle 

This determines the rotation intervals that the nesting software will use to locate the part.  
The choices are 0 (no rotation), 5, 10, 30, 45, 60, 90, 120, and 180.   Decreasing the rotation 
interval (for example from 90 to 10) may improve the nesting efficiency however the time 
required to create the nest will increase dramatically.  For most common rectangular parts, 
the rotation angle should be set to 90. 

Note: This field will be disabled when Grain Direction is set to either X or Y. 

Material 

This displays the name of a material and thickness combination in a drop-down list.  The list 
of materials is maintained in the Configuration window. This entry is used to check sheet 
compatibility. 
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Grain Direction 

This selection sets the grain direction of the part.  The 3 choices are None, X (Horizontal), or 
Y (Vertical).  If X or Y is selected and the sheet also has a grain direction selected, the part is 
only nested with the same direction as the sheet.  If the sheet has no grain direction specified 
and the part does, an error message is displayed when the nest is created. 

Sequencing 

 

 

This dialog is used to edit the cutting sequence of the part, to change the cutting direction of 
features and to change whether features are cut out as inside or outside cutouts.   The 
numbers inside of the features indicates the current cutting sequence, inside cutouts are in 
black, and outside cutouts are in red. The dashed line shows the rapid moves between 
features.   

 

To change a feature, click anywhere on that feature and a dialog box will appear showing the 
current sequence number.  
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To change the cutting sequence, enter the new sequence number and press OK.  The 
sequence number will change and the remaining features will be re-numbered. 

To change the cutting direction or cut type, toggle the state of the appropriate button and 
press OK. 

Feature Avoid 

Pressing the Feature Avoid button will run the feature avoidance software and automatically 
sequence the part for head down operation.  Note: If feature avoidance was run when the 
part was first converted from a CAD file, it does not need to be run again here. 

For more information on Feature Avoidance parameters, see the Preferences configuration 
page. 

Animate 

Pressing the Animate button causes the following dialog to appear: 

 

This screen is used to animate the cutting sequence.  Press the Play button to start the 
animation.  The animation speed is controlled by the slider control on the right side and the 
"by Entity" and "by Feature" radio buttons.  The "by Entity" selection causes each entity to be 
drawn by itself whereas the "by Feature" selection causes the entire feature to be drawn at 
once.  Pressing the Stop button returns to the previous Sequencing dialog. 

Note: If the part is using a Precut Edge, the animated cutting sequence for the outline will not 
reflect the proper sequence.  The cutting sequence for the outline will appear the same as a 
normal part.  

Toggle Int/Ext 

This button will change all interior cuts to exterior and all exterior cuts to interior.   

Resequence 

The cutting sequence of the entire part can be manually changed easily by pressing the 
Resequence button.  After the Resequence button is pressed, select the features one at a 
time in the desired cutting sequence, starting with the first.  To start resequencing at some 
other point, hold the shift key down while selecting the desired starting feature.  For example, 
if a part has 30 features and the cutting sequence is OK for the first 25 features, hold the shift 
key down and select the 25

th
 feature.  Then select the remaining 5 features in the desired 

cutting order. 
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Open Geometry 

It is sometimes desired to add cutter compensation to open geometry, the sequecing dialog is 
where this done.  When the operator clicks on an open geometry feature, the following dialog 
will appear: 

 

All open features default to No Cutter Comp, but it can be changed to either Left or Right.  
Changing the Cut Direction toggles the start end of the open geometry. 
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Corner Radius 

 

This dialog is used to add and remove corner radii.  Added radii are shown in red. If the 
mouse is stopped over a radius that has been added, it's radius will be displayed in a pop up 
window as shown above. 

Radius 

The size of the radius that will be added. 

Max Angle 

If an intersection has an included angle less than or equal to this value, a radius can be 
added to the corner.  If the included angle is greater than this value, a radius can not be 
added. 

Min Length 

A corner radius is not inserted if it would make either the modified entity or the arc itself 
shorter than this parameter. 

Add to All 

Pressing this button will add a radius to all intersections of the part that meet the Max Angle 
and Min Length criteria. 

Remove All 
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This button deletes all corner radii inserted by this software.  Original CAD arcs are not 
affected. 

Selection Method 

This list box determines how arcs are added/removed.  The 2 choices are: 

Intersection - The mouse is used to click on individual intersections.  If a selected intersection 
meets the Max Angle and Min Length criteria, an arc is added.  If an added arc already 
exists, it is removed and the original intersection is restored. 

Path - The mouse is used to click on a path.  A radius is added to all intersections on that 
path that meet the angle and length criteria.  Selecting a path again removes all of the added 
arcs. 

In addition to these two methods, a window can be drawn around intersections.  Press and 
hold the left mouse button to start the window, drag the window to the desired size, and 
release the left mouse button.  All intersections inside of the window that meet the angle and 
length criteria will have a radius added.  Repeating the process will remove the added arcs. 

Exact Stop 

 

This dialog is used to add exact stop commands to a part.  An exact stop causes the machine 
motion to come to a complete stop before the next move is started.  It is often used to get 
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very sharp corners with no rounding.  All intersections that have an exact stop programmed 
will have a G09 added in the output CNC program.  

Maximum Angle 

If this is enabled with the check box, then no intersection whose included angle is greater 
than the indicated value can have an exact stop added.  If this is not enabled then all 
intersections can have an exact stop added. 

Add to All 

Pressing this button will add an exact stop to all intersections of the part that meet the 
maximum angle criteria. 

Remove All 

This button deletes all exact stops from the part.  

Selection Method 

This list box determines how exact stops are added/removed.  The 2 choices are: 

Intersection - The mouse is used to click on individual intersections.  If a selected intersection 
meets the maximum angle criteria, an exact stop is added.  If an exact stop already exists, it 
is removed. 

Path - The mouse is used to click on a path.  An exact stop is added to all intersections on 
that path that meet the maximum angle criteria.  Selecting a path again removes all of the 
exact stops. 

In addition to these two methods, a window can be drawn around intersections.  Press and 
hold the left mouse button to start the window, drag the window to the desired size, and 
release the left mouse button.  All intersections inside of the window that meet the maximum 
angle criteria will have an exact stop added.  Repeating the process will remove the exact 
stops. 
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Corner Looping 

 

This dialog is used to add corner loops on the exterior feature of a part.  Corner loops can be 
used to get  very sharp corners on the part without making the machine motion come to 
complete stop.    

Radius 

The radius of the corner loop that will be added. 

Max Angle 

If an intersection has an included angle less than or equal to this value, a corner loop can be 
added to the corner.  If the included angle is greater than this value, a corner loop can not be 
added. 

Add to All 

Pressing this button will add a corner loop to all intersections on the exterior feature of the 
part that meet the maximum angle criteria. 

Remove All 

This button deletes all corner loops from the part.  

Selection Method 

This list box determines how corner loops are added/removed.  The 2 choices are: 
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Intersection - The mouse is used to click on individual intersections.  If a selected intersection 
meets the maximum angle criteria, a corner loop is added.  If a corner loop already exists, it 
is removed. 

Path - The mouse is used to click on a path.  A corner loop is added to all intersections on 
that path that meet the maximum angle criteria.  Selecting a path again removes all of the 
corner loops. 

 

Arc Tolerance 

 

This dialog is used to change the arc tolerance.  Arc tolerance is the radial error parameter 
used to calculate arc feedrate.  See "Arc feedrate parms" for more information. 

Arcs that use the default tolerance are displayed in red and all arcs that have a "custom" 
value are displayed in green.  Stopping the cursor over a custom (green) arc displays the 
tolerance value for that arc in a pop up window. 

Default 

This is the default tolerance for all arcs in the part that haven't been given a "custom" 
tolerance.  
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Default All Arcs 

The button causes all arcs to go back to default settings, erasing any custom tolerances 
programmed. 

Selection Method 

This list box determines how arc tolerances are changed.  The 2 choices are: 

Arc - The mouse is used to click on individual arcs.  When an arc is selected, a dialog box is 
displayed showing the current tolerance for that arc: 

  

Enter the new tolerance and press OK.  Pressing the "Default" button changes the arc 
tolerance back to the default value. 

Path - The mouse is used to click on a path.  The same dialog as above appears however it 
will now apply for all arcs on the path. 

In addition to these two methods, a window can be drawn around arcs.  Press and hold the 
left mouse button to start the window, drag the window to the desired size, and release the 
left mouse button.  The dialog as above appears however it will now apply to all arcs within 
the window. 
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Process Type 

 

This dialog is used to assign different process types to paths.  In the picture above, the path 
shown in red is using the "Etch" process and the black features are using the "Cut" process. 

To change a path to a different process type, first select the active process type from one of 
the available process types using the list box on the right side of the dialog. Note: The 
process names can be customized by the user in the "Process Parameters” configuration 
page.   

The Auxiliary cutting processes using the dotted lines are only available on the CL6 –160i.  
The auxiliary cutting processes utilize the G01S_P_Q_F_ functions of the 160i control to 
change the laser power, frequency, duty cycle, and feedrate.  The actual values used are 
programmed in the material library file. 

Setting the process type to Ignore will cause the feature to be ignored when nesting and 
posting NC code.  The outline of the part cannot be set to Ignore. 

Set All Paths 

This button causes all paths to change to the active process type.  

Selection Method 

Path - The mouse is used to click on a path.  The path will become whatever the active 
process type currently is. 
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Segment - The mouse is used to select individual segments of a path.  If a feature uses 
multiple process types, the NC code posted for the part will turn the beam off (with a M35), 
issue a new G89 line to change cutting parameters, and then turn the beam back on.   

Special note regarding Etch process 

Any feature that has the process type set to Etch will have any lead in associated with it 
removed and no lead in can be added to it in the future.  In addition, when NC code is posted 
for the part, cutter compensation will not be applied to any feature that uses the Etch 
process.  

 

Lead In / Out 

 

This dialog is used to modify parameters of the lead-ins / outs as well as their location.  It is 
also used to add multiple tabs to a part. 

To move the lead in location for a single feature, simply hold down the SHIFT key and click 
on the desired lead in location.  The lead in should move to the new location. 

Auto Locate 

Pressing the Auto Locate button will move the lead in location for all features to the optimum 
location for head down operation.  This is similar to running Feature Avoidance, except that 
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the cutting sequence will not be changed.  This function can be useful if the cutting sequence 
has been manually changed. 

Edit All Lead Ins 

This button is used to edit all the lead ins / outs on the part at one time.  Pressing it causes 
the following dialog to be displayed: 

                              

Lead In 

The software supports two types of lead ins, simple one piece linear lead ins and "custom" 
lead ins.  Custom lead ins can be made up of multiple arcs or lines with varying feedrates and 
dwells.  For more information on custom lead ins, see the Custom Lead In file description. 

Custom Lead In - This checkbox determines which type of lead in will be added to the part, a 
custom lead in or a simple lead in.  If it is checked, a custom lead in will be used and the lead 
in section of the dialog will change to: 

                        

Lead in name - This is the name of the custom lead in file that will be used for the part.  See 
the Custom Lead In File section for information on creating these files. 

Pressing the Browse button will display the Lead In File selection dialog: 
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Selecting a lead in file will display a preview of the lead in and also display the extents and 
any notes that have been entered for the lead in.  Press the OK button when the desired 
custom lead in file has been selected. 

 

If the Custom Lead In checkbox is not checked, then a simple linear lead in will be used.  The 
following parameters control the simple lead in. 

Length - This is the length of the lead in.  It should be set to 0.000 if no lead ins are desired. 

Angle - This is the angle the lead in makes with the first entity of the feature. 

Feedrate - This is the feedrate used for the lead in.  It can be entered as either an absolute 
value in inches/min (mm/min) or as a percentage of the process feedrate listed in the material 
list. 

Exact Stop - This determines whether or not an exact stop is used after the lead in. 

Lead Out 

The software also supports two types of lead outs, simple one piece linear lead outs and 
"custom" lead outs.  Custom lead outs can be made up of multiple arcs or lines with varying 
feedrates and dwells.  For more information on custom lead outs, see the Custom Lead Out 
file description. 

Custom Lead Out - This checkbox determines which type of lead out will be added to the 
part, a custom lead out or a simple lead out.  If it is checked, a custom lead out will be used 
and the lead out name will be displayed. 
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Length - This is the length of the simple lead out.  It should be set to 0.000 if no lead outs are 
desired.   

A negative value for lead out can be used to create a tab on a part. This can be useful to 
prevent parts from tipping or to keep small parts from falling into the scrap tray.  In this case, 
the angle field is not used. 

Angle - This is the angle the simple lead out makes with the last entity of the feature. 

Pressing the OK button will change all lead ins / outs on the part to the new parameters.  
Pressing Cancel will not change anything. 

Selection Method 

Path - The mouse is used to click on a path.  The following dialog will appear: 

                

This dialog is almost the same as the previous dialog except that additional controls are 
available to change the location of the lead in.  The 2 buttons are used to move the lead in 
either clockwise or counter-clockwise around the feature.  The slider bar determines how 
much the lead in moves for each press of a button.  If the slider bar is moved to the extreme 
right (most coarse), the increment is exactly one half of the entity length. 

Window - The mouse is used to draw a window around paths.  Press and hold the left mouse 
button to start the window, drag the window to the desired size, and release the left mouse 
button.  The same dialog that appears with the Edit All Lead Ins will appear.  The only 
difference is that when the OK button is pressed, only those paths that lie completely inside 
of the selection window will have their lead ins changed. 

Tabs 

 

Part tabs can be created in two ways.  The first way is to use a negative lead out length as 
explained above.  This has the limitation of having only one tab per feature and always 
located at the lead in location. 
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The second way to add part tabs is to press the Tabs button and clicking on the part where 
the new tabs are to be located.  This method allows an unlimited number of tabs to be added 
to a part at any location.   After clicking on a location on the part, the following dialog will be 
displayed: 

  

Enter the desired tab length, press the OK button and the new tab will be added to the part.   

The “Inherit lead in/out properties from feature” checkbox determines whether the tab uses 
the same lead in and lead out that the feature itself uses or if it uses it own settings.  If the 
checkbox is not checked, the Lead In and Lead Out sections will be enabled and values can 
be changed.  These values affect only the current part tab, they will not affect any other tabs 
or the current feature.  

To lengthen or shorten an existing tab, select it with the mouse and change the tab length.  
To delete a tab, select it with the mouse and press the Delete button. 

Delete All Tabs 

This button can be used to delete all tabs from a part. 

Auto Tab 

Multiple tabs can be added automatically by pressing the Auto Tab button.  When this button 
is pressed, the following dialog will be displayed: 



 

80  ••••  Part Files Laser Programming and Nesting Software  

 

The first control determines which paths will be auto tabbed, External, Internal or all features 
can be auto tabbed.  

The second control determines where the tabs will be located.  The first setting, Locate tabs 
by distance will add multiple tabs at the specified distance around the feature starting at the 
lead in location.   The second method, Locate a pair of tabs on opposite sides at center, 
will add a pair of tabs at the center of the part.     
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Optional Gas 

 

The screen is used to program optional gas pressure (M67) at different locations on the part.  
The red squares on the display indicate where an M67 has been programmed. 

 

To add an M67 after the lead in of a particular feature, make sure the top radio button labeled 
"M67 after lead-in of selected path" is selected.  Then click on the desired feature and a red 
box will be displayed after the lead in indicating that a M67 will be issued at that point.  
Clicking on the feature again will remove the M67. 

 

To add an M67 at some other point on a feature, make sure the bottom radio button labeled 
"M67 at selected intersection" is selected.  Then click on any intersection on a feature and a 
M67 will be added to that intersection.  Clicking on the same intersection will remove the 
M67.   

 

Note:  Only one M67 can be programmed per feature.  If a feature already has an M67 and 
another is added, the first M67 will be removed. 

Dwell after M67 

If this option is selected, a dwell of the desired time period will be inserted in the NC code 
after each M67.  This is useful to allow the assist gas pressure to stabilize at the new setting 
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before continuing motion.  This value can be set using a variable in the NC code if the Use 
Variable for Dwell after M67 option is turned on in the "Common Posting Options - 2" page 
of the configuration.    

After All Lead-ins 

This button will add an M67 after the lead in to all features on the part.   

Remove All 

This button will remove all M67's programmed on the part. 

Z Axis Servo Hold 

 

Two different types of Z Axis servo hold can be programmed, M36 and M38.  M36 is a servo 
hold that lasts for the remainder of the feature and M38 is a servo hold that lasts for a certain 
time value.   M36's are displayed as red squares and M38's are displayed as green squares. 

Note a feature can only contain a single M36 or a single M38.  If a feature already has an 
M36 or M38 and another is added, the first servo hold will be removed. 

 On the CL-707 laser, the time value for M38 is programmable in milliseconds using a P 
argument, for example M38 P300 would cause a servo hold to last for 300 milliseconds.  On 
all other lasers, the time value is set using a diagnostic location on the laser control and is not 
set via the NC program. 
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To add a servo hold to a feature, first select the desired type of servo hold (M36 or M38) 
using the radio buttons at the top of the dialog.  Then select where the servo hold will done 
using the combo box.  The choices are: “After pierce of selected path", “After lead in of 
selected path”,  and "At selected intersection".  Clicking on the feature again will remove the 
servo hold. 

After All Pierces 

This button will add the current servo hold after the pierce of all features on the part.  

After All Lead Ins 

The button will add the current servo hold after the lead to all features on the part.  

Remove All 

This button will remove all M36's and M38's programmed on the part. 

Ramped Start/End 

 

The Ramped Start /End function divides the beginning or ending entities of a path into short 
segments that are commanded with different feedrates. The "Start" segments are 
programmed after the lead-in and the "End" segments are before the end of cut or lead-out. 

A feature can contain a ramped start, a ramped end, or both a ramped start and end.  
Ramped start's are indicated as red squares on the display, ramped ends are indicated as 
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green squares, and a split red/green square indicates that a feature has both a ramped start 
and end. 

On the 160i control, Auxiliary cutting parameters can be programmed for the first step of a 
ramped start and/or the last step of a ramped stop.  This can be sometimes useful to 
overcome start of cut problems. 

Add to All 

This button adds a ramped start, end or both (depending on the radio button selected on the 
right side on the dialog) to all features on the part. The following dialog will be displayed: 

 

Number of segments - This determines the number of segments that will be created at the 
beginning (or end) of the feature.  The choices are from 1 to 5.  

Segment length - This is the desired length of each of the segments.   

Note: If the number of segments times the segment length exceeds the original length of  the 
entity, the segment length will automatically be reduced.  For example if the number of 
segments is set to 5 and the segment length is 0.1" the total length of the ramped start would 
be 5 * 0.1" = 0.5".  If the original entity is only 0.4" long,  the segment length will automatically 
be shortened to  0.4" / 5 = 0.08". 

Feedrate - These values determine the feedrate used for each segment of the ramped start 
or end.  The feedrate can be specified as either a percentage of the process feedrate or as 
absolute feedrate values specified in ipm (or mm / min).  Use the "Percentage" and "Value" 
radio buttons to determine which method is used. 

Aux Cut  - (CL6–160i only)  If this option is selected, the first segment and the entire lead-in 
will use the auxiliary cutting parameters specified in the material library file.  The feedrate for 
the first segment cannot be specified in this case, because the feedrate has already been 
specified in the material library file.   

The Remove button is used to remove a ramped start or end from a feature. 

A similar dialog box is used to enter the ramped end parameters.  The ramped start and 
ramped end parameters can be different if desired. 

Remove All 

This button removes all ramped starts and ends from all features on a part. 

Selection Method 

Path - The mouse is used to click on a path and a ramped start, end or both is added to the 
path or if one already exists, the parameters can be edited. 
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Window - The mouse is used to draw a window around paths.  Press and hold the left mouse 
button to start the window, drag the window to the desired size, and release the left mouse 
button.  All paths that lie entirely within the window will have a ramped start, end, or both 
added.  If one already exists, the parameters can be edited. 

Corner Ramping 

 

The Corner Ramping function is used to change the feedrate when approaching and leaving 
a corner.  The approaching and leaving entities are divided into segments commanded with 
separate feedrates. Corner ramping is indicated with a red square on the display. 

Maximum angle 

If an intersection has an included angle less than or equal to this value, a ramped corner can 
be added to the corner.  If the included angle is greater than this value, a ramped corner can 
not be added. 

 

Add to All 

This button adds a ramped corner to all possible intersections on the part. The following 
dialog will be displayed: 
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This dialog is used to change the parameters for the ramp into a corner.  A similar dialog 
titled "Edit Ramp Out of Corner" is used to change the parameters for the ramp out of a 
corner.  It will appear after the OK button is pushed on the first dialog. 

Number of segments - This determines the number of segments that will be created leading 
into (or out of) the corner.  The choices are from 1 to 3.  

Segment length - This is the desired length of each of the segments.   

Note: If the number of segments times the segment length exceeds one half of the  original 
length of  the entity, the segment length will automatically be reduced.  For example if the 
number of segments is set to 3 and the segment length is 0.1" the total length of the ramp 
into the corner would be 3 * 0.1" = 0.3".  If the original entity is only 0.4" long,  the segment 
length will automatically be shortened to ( 0.4" / 2)  / 3 = 0.066". 

Feedrate - These values determine the feedrate used for each segment of the ramped 
corner.  The feedrate can be specified as either a percentage of the process feedrate or as 
absolute feedrate values specified in ipm (or mm / min).  Use the "Percentage" and "Value" 
radio buttons to determine which method is used. 

Aux Cut  - (CL6–160i only)  If this option is selected, the last segment of the ramp in (or the 
first segment of the ramp out)  will use the auxiliary cutting parameters specified in the 
material library file.  The feedrate for this segment cannot be specified in this case, because 
the feedrate has already been specified in the material library file.   

The Remove button is used to remove a ramped corner from an intersection. 

Remove All 

This button removes all ramped corners from the part. 

Selection Method 

This list box determines how ramped corners are added / edited.  The 2 choices are: 

Intersection - The mouse is used to click on an intersection.  If the intersection meets the 
maximum angle criteria, a ramped corner will be added.  Clicking on an existing ramped 
corner allows the parameters to be edited.  

Path - The mouse is used to click on a path and a ramped corner is added to all possible 
intersections on the path. 

In addition to these two methods, a window can be drawn around intersections.  Press and 
hold the left mouse button to start the window, drag the window to the desired size, and 
release the left mouse button.   All intersections that lie within the window and meet the 
maximum angle criteria  will have a ramped corner added. 
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Start Cut 

 

This dialog is used to change the type of pierce used to start the cutting process.  When a 
new part is created, all pierces are set to a “normal” pierce, using G84.  If the CINCINNATI 
Laser System is equipped with the Rapid Pierce option, the part can be edited so that certain 
features use a rapid pierce or “G84 T2”.  The part can also be edited to start a cut without 
piercing, even when the active process parameters include a pierce time.  This is done by 
setting the start of cut to G85 (or G84 T3 for CL-6 and CL-7A).  

By default, all paths begin with G84.  Select a path to toggle the start of cut between G84, 
G84 T2, and G85.   

Set all paths to G84 

This button sets all paths back to use G84.  

Set all paths to G84 T2 

This button sets all paths back to use G84 T2.  This is only available if the machine has the 
Rapid Pierce option.  

Set all paths to G85 or (G84 T3) 

This button sets all paths to use G85 or  G84 T3 (no pierce).  
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Corner Blend 

 

This menu is available for the CL-707, CL-800, CL-900 and CL-400 only and is used to set 
the blend mode used for the part. For more information on the different blend modes and how 
they are used, please refer to the CL-707 Programming Manual (EM-423). 

The three radio buttons: G123, G124, and G125 set the overall blend mode for the part.   
G125 (Auto blend) mode should be used for most parts. 

Individual intersections can have "Local G123's" programmed, indicated by the red squares.  
This can be used to set "special" blend times for particular intersections.  To add a Local 
G123, click on any intersection.  The following dialog will appear: 

                    

The A and S values specify the overall blend time and the S curve time respectively.   
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Remove All Local G123's 

This button will remove all Local G123's that have been added to the part.  

Text 

 

This window is used to add text to a part, for example part numbers or other identification 
marks.  Text is displayed in blue. 

Pressing the Add Text button will display the following dialog: 
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The first time that text is added to a part, the text string will default to the part name without 
the ".prt" extension.  The length of the text string is not limited however it is limited to the 
following characters: A-Z, 0-9, = + - * . < > [ ] ( ) / \ and _. 

When the OK button is pressed, the text will be added to part at the given height and rotation.  
The location of the text can be changed by dragging the text to a new location.  Holding down 
the CTRL key while moving the mouse can change the rotation of the text.  It is the user's 
responsibility to insure that the etched text lies completely on the part, the software will not 
check for this. 

Text can be edited by double clicking on the existing text string which will reopen the above 
dialog.  Entering an empty string will delete the text.  The process used to cut the text can be 
edited in this window or later in the Process Type window. 

Incrementing Part Numbers 

This feature allows adding numeric text to a part that automatically increments in the CNC 
code.  This allows a single part file to be used to cut a sequence of parts with incrementing 
part numbers.  For example, the following part contains a normal text field and an 
incrementing part number field: 
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It can be used to generate the following nest file: 

 

 

Incrementing part number fields are added to a part in the “Text” part editing window.  When 
the “Add Text” button is pressed, the following dialog will appear: 
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To change a normal text field to an incrementing part number field, click the checkbox at the 
top of the dialog.  Click on the “Parameters..” button and the following dialog will appear: 

 

 

This dialog controls the formatting of the part number.  The available fields are: 

Number of digits: This controls the number of digits used for the part number field.  Leading 
zeros are always added to maintain this width.   

Start at: This is the starting number of the sequence; the default is one [1].  

Current value: This value is the next number that will be generated in the next NC code, it 
must be between the “Start at” and “End at” values.  

End at: This is the ending number of the count after which the sequence will start again. 

Increment: This is the numeric field for setting the increment of the numbering for the 
individual parts. The maximum increment value is 100000; default value is one [1].  

Repeats: this value specifies he number of times a number is repeated before incrementing 
to the next number. The default value is one [1].  

Current repeat: this is the current value of the repeats and is used to maintain the 
sequencing between different nests.  This must be between 1 and the value of “Repeats”.  

 

Example: 

Number of digits: 1, Start at: 1, Repeats: 1, Increment: 1, End at: 5, Current value: 3, Current 
repeat: 1 

Results: 3, 4, 5, 1, 2, 3, 4, 5, 1, 2, 3, …. 

 

Example: 

Number of digits: 3, Start at: 1, Repeats: 5, Increment: 2, End at: 3, Current value: 1, Current 
repeat: 1 

Results: 001, 001, 001, 001, 001, 003, 003, 003, 003, 003, 001, 001, 001 … 
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When a CNC file is generated for a nest that contains parts with Incrementing Part Numbers, 
the following dialog will appear: 

 

The user can verify that the sequence numbers are correct and change them if desired by 
clicking on the edit button. 

When the OK button is pressed, the CNC code will be generated with the part numbers 
incrementing as specified.  The current value of the sequence will automatically be saved 
after the CNC code is generated so that the next time the same part is used in a nest, the 
sequence will continue where it left off. 

Incrementing part numbers can be automatically added to a part when it is created if the 
original text file contains question mark characters (“?”) and the Convert Text function is 
used.  This allows a drawing to specify the location and size of the part number field.  The 
number of question marks determines the number of digits of the part number field. For 
example, if the drawing contains the text field: “????”, a 4 digit incrementing part number field 
will be added to the part.   Note:  This will only work if the font is changed to the Simple font 
when the part is created, it will not work when the font is set to “Don’t change font”. 

Order Number 

This feature allows adding text to a part file that will be changed to the order number entered 
when the part is used in a nest.  To use this feature, the “Display order number column” 
option in the Preferences configuration page must be turned on.   

To add an Order Number field to a part, check the Use Order Number checkbox on the Edit 
Text dialog: 
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A new text field will be displayed on the part called “**ORDER**”.  Move this to the desired 
location on the part making sure that there will be sufficient room for actual order number field 
when it is filled in. 

 

Now when the part is added to a nest and the order column is filled in, when the NC code is 
created, the “**ORDER**” text will be replaced with the text in the order number column.  
Note:  Make sure that the text used in the order number column contains only valid etched 
text characters (Upper case alpha, numeric or one of the special characters above). 

The following example shows the same part added to a nest twice using two different order 
numbers: 
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The following is a plot of the NC code created, notice the order numbers are different: 
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Z Axis Antidive 

 

This window is available on the CL-707, CL-7A PC, and the CL-6 160i and is used to turn off 
the Z Axis Antidive function of the laser system by inserting M130's at appropriate locations in 
the NC code. 

M130 is used for applications where there is significant material vibration.  M130 allows the 
head to follow moderately warped material or thin gauge material that flutters due to 
interaction with assist gas pressure. 

However, programmers are advised to carefully consider the application before using 
M130.  If the head is programmed to travel over a hole in M130 mode, a nozzle 
breakaway will most likely result, possibly damaging the head. 
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Smart Rapids 

 

This menu is available for the CL-707 and CL-7A PC only and is used to edit the Smart Rapid 
path.  Smart rapid paths are displayed as green, red, and yellow line segments.  The green 
segment is the extension of the final cutting move on the previous feature, the red segment is 
the high speed move, and the yellow segment is the slow down move approaching the next 
feature.  The green squares show the area where the beam will turn on and the red squares 
indicate the area where the beam will turn off.   

 If a rapid move is displayed as an orange dashed line instead of a multi-color line, that 
means that smart rapids are not being used for that move.  To use Smart Rapids the 
following must all be true: 

1. Smart Rapids must be enabled on the CL707 Posting Options configuration page. 

2. The process library file used by the part must have a pierce time of 0 and a pre-cut dwell 
time of 0. 

To edit a Smart Rapid path, click on a feature and the following dialog will be displayed: 
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The “Smart rapid into feature” and “Smart Rapid out of feature”  checkboxes can be used to 
turn off smart rapids for a particular feature.  Smart rapids are never used going into the first 
feature of a part or leaving the outline of a part. 

The “CCW Cut Direction” checkbox determines whether the feature is cut counter-clockwise 
(default) or clockwise.  Changing this can alter the Smart Rapid path a great deal. 

The "Move Lead Location" control moves the lead-in location around the feature just like in 
the Lead In/Out window. 

In order to use Smart Rapids effectively, keep the following items in mind: 

Even though Smart Rapids are enabled, a given rapid move will be conventional (i.e. straight 
line with dwells at both ends) if any of these conditions apply: 

Dwell (G04), Exact Stop (G09) or Partial Z Up (M47) programmed at either end of the 
rapid move. 

Rapid Pierce (G84 T2) used immediately after rapid move. 

The feature at either end of the rapid move is “open”. That is, the cut does not close on 
itself, producing a slug that will drop. 

Rapid move length exceeds the “Minimum G0 Distance” which triggers an Auto M47 (Z 
Up). This parameter is specified on the “Z Axis Setup” dialog on the CL-707 control. 

The following can cause unexpected pausing during Smart Rapid operation: 

Use of Optional Assist Gas Pressure (M67). 

Failure to disable anti-dive (M130) on material that is prone to vibrate. 

Finally, in order to get accurate path indications and run times from the Nesting Software, 
make sure the following “Time Study Parameters” match those of the target machine: 

X, Y Rapid Speed,  X, Y Acceleration, 

Machine Jerk,   Cutting Jerk 
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Optional Z Standoff 

 

This window is only available for the CL6 160i, the CL707 and the CL7A PC.  It is used to 
program optional Z standoff distance (M45) at different locations on the part.  The red 
squares on the display indicate where an M45 has been programmed.  

After All Lead-Ins 

This button adds a M45 after the lead in move on all features of the part.  

Remove All 

This button removes all M45’s programmed on the part.  
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Dynamic Assist Gas 

 

This window is only available for the CL6 160i.  It is used to turn dynamic assist gas on at 
different locations on the part, using a M68.  The red squares on the display indicate where 
an M68 has been programmed.  

After All Lead-Ins 

This button adds a M68 after the lead in move on all features of the part.  

Remove All 

This button removes all M68’s programmed on the part.  

Setup Notes 

 

This window is used to enter optional text concerning the part, such as part number, revision 
level, etc.   Any text entered here will also be added as program comments to the NC file if 
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the “Part Setup Notes” field is checked in the Program Comments section of the “Common 
Posting Options –2” configuration page. 

The Customize button can be used change the default labels (“Part Number –“, “Change 
Letter –“, and “Parts per Blank”.  Pressing it will display the following dialog: 
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Precut Edge 

 

This window is used when one edge of the outline of the part has already been cut by 
another process, for example a shear.  This edge is placed along the X axis of the laser when 
the part is cut.   

NOTE:  This feature is only available for CNC files created from a single part  (see Create NC 
for more information).  If a part with a precut edge is added to a nest, the precut edge will be 
ignored and the part will be nested as a normal part. 

The NC code for the part will cut the interior features first as in a normal part.  If the lead-in 
for the outline is located on the precut edge, the cut will start at the right most intersection of 
the precut edge and continue around the part counter-clockwise until the precut edge is 
reached again.  If the lead-in is not on the precut edge, the cut will begin at the programmed 
lead-in location and continue counter-clockwise around the part until the precut edge is 
reached.  The head will be raised and will rapid back to the lead in location.  Cutting will 
resume in a clockwise direction until the cut is finished. 

Part has precut edge 
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This checkbox turns on the precut edge feature.  When it is checked, the software will look for 
a straight edge located at the bottom of the part.  If one is found, it will be highlighted in red, if 
not, an error message will be displayed stating that a valid edge was not found. 

If this is not the proper edge, a different edge can be selected by picking a straight edge with 
the mouse.  The part will rotate so that the new edge is oriented along the bottom.   

Extend cut beyond precut edge 

This value determines how far beyond the Y=0 edge the part will be cut to insure that it is 
completely cut out.  It must be between 0.0” and 0.5”. 

Minimum X Coordinate 

This value determines how far the part will be cut from machine X0.   It defaults to 0.25” but 
can be changed to anything between 0.0” and the maximum X travel limit for the machine.   

 

 

Location/Rotation 

 

This window is used to rotate the part or shift the part’s machine coordinates.  The machine 
coordinates are only used when single part CNC files are created and is very useful when 
used with parts without outlines. 
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To change the machine coordinates of the part, pick any intersection with the mouse and the 
current machine coordinates for that intersection will be displayed.  Enter the desired 
machine coordinates and press the OK button.   

To rotate a part, press either the rotate clockwise or rotate counter-clockwise buttons.  The 
increment field controls how much the part is rotated for every button press.  

The rotation and location functions are disabled for parts that have the Precut Edge feature 
turned on. 

The Mirror Image button can be used to create a mirror image of the part.  

Center Pierce 

 

This window is used if a pierce hole needs to be made at the center of a feature and the 
feature itself does not need to be cut out.  This is used sometimes on thick material with small 
holes where the laser is used to mark the center of the hole so it can be drilled later.  
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Optional Stop 

 

This window is used to program optional stops (M01) after features in a part.  The red 
squares on the display indicate where an M01 has been programmed.   Optional stops can 
be used to check the cutting process before continuing on the rest of the sheet. 

Remove All 

This button removes all M01’s programmed on the part.  
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Feedrate 

 

This window is used to specify a custom feedrate for a particular feature or segment.  The 
feedrate can be specified as an absolute value (in IPM) or as a percentage of the process 
feedrate (variable #148). 

Selection Method 

Path - The mouse is used to click on a path.  The feedrate for the entire path can then be 
changed. 

Segment - The mouse is used to select individual segments of a path. 

Remove All 

This button removes all custom feedrates from the part.  

 

 



 

Laser Programming and Nesting Software  Part Files  ••••  107 

Offset Features 

 

This window can be used to offset features to make them either smaller or larger up to 
1.000”.   To make a feature smaller, enter a negative offset value.  Positive offset values 
make a feature larger.  If a feature has been offset, the original geometry will be drawn using 
a dashed line and the offset geometry will be drawn using a red line. 
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End of Cut 

 

This dialog is used to change the way the cutting process is stopped.  Normally, the cutting 
process is terminated with a M35.  M37 is the same as a M35 except it also causes the laser 
shutter to close.  This is useful in some cases when simmer current is used with the laser and 
inadvertent marking of the part occurs.  The M37 will eliminate the marking, but the 
processing time will increase because the laser must wait for the shutter to open before the 
start of the next feature.   

Set all paths to M35 

This button sets all paths back to use M35.  

Set all paths to M37 

This button sets all paths to use M37.    



 

Laser Programming and Nesting Software  Part Files  ••••  109 

Vision System 

 

This dialog is only available if the Vision System option is selected on the Posting Options 
configuration page and is used when the laser system is equipped with the optional Cognex 
vision system camera.   For more information, please consult the separate Vision System 
Option manual supplement. 

This window is used to pick the 2 features that will be used to locate the part on the 
preprocessed sheet.  For the best accuracy, the two features should be located as far apart 
as possible.  Also any shape of preprocessed feature can be used but round holes will yield 
the best accuracy.  Click on a preprocessed feature to select Feature 1 and shift click on a 
feature to select Feature 2.   The location hint field is used when several preprocessed 
features may be visible in one picture the vision system takes.  The hint helps the Vision 
System locate the proper feature.  In the part above, the red hole (feature 1) is set for lower 
left because it is the lower left hole in the group.  The purple hole (feature 2) is set for upper 
right because it is the upper right hole in the group.   

The tolerance field should be set to the maximum allowable tolerance that is acceptable.   
When the vision system runs, the programmed distance between the two location features is 
compared to the actual distance between the features the vision system locates.  If the 
distance differs more than the tolerance, the program will stop.  This helps prevent the 
operator from selecting the wrong features on the part. 
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When NC code is generated for the part, the following macro line will be automatically 
inserted in the code: 

G65 P9731 A2 B2 E2 D0 C0.125 X6.5 Y3.75 K1 J0 I0.125 T0.01 

 

Dwell 

 

This dialog can be used to add a dwell (G04) after any segment.  To add a dwell, just click on 
the segment where the dwell should be after and when prompted, enter the dwell time in 
seconds.  
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Group Files 

Overview 
A group file is a collection of one or more part files saved with the .GRP extension.  It can be 
used to group together several parts that make up an assembly to make creating a nest 
easier.   

In addition, a structured group can be set up which is a group with a layout predefined.  You 
specify parts and their location within a "sub-nest".  This can be useful if you know exactly 
how you would like a particular combination of parts to be nested together. 

To create a new group file, select the New menu item under the File menu.  Then select 
"Group File". 

The following pages describe Group Files in further detail. 

Simple Groups 
The following is a picture of a simple (unstructured) group: 

 

A simple group is just a list of different parts and quantities for each one.  Note that the 
Structured Group checkbox is not checked.  A simple group file can consist of up to 100 
individual parts. 
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Add 

To add a new part to the group, press the Add button and the following dialog will be 
displayed: 

 

If the Preview part checkbox is checked, a picture of the selected part will be shown in the 
lower right corner of the dialog and the part dimensions and material will be displayed in the 
lower left corner. 

After the desired quantity is entered, press the OK button to close the dialog and add the part 
to the group. 

Delete 

This button is used to delete the selected part from the group.  The part file itself is not 
deleted, the part is just taken out of the part's list for the group. 

Edit 

This button is used to edit either the name or quantity of an existing part.  Pressing it or 
double clicking on an entry in the part's list will display the above dialog. 

Import Part List 

This button is used to import a text file into the part's list.  After pressing this button, you will 
be prompted for the name of a text file.  This file must be in the following format: 

PartName1      Quantity1 

PartName2      Quantity2 

etc. 
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Note: The part name in the file should include the entire pathname.  In addition, the part 
name must be enclosed in double quotes (") if the pathname contains space characters.  

Example: 

C:\LASERNST\PARTS\PART1.PRT    2 

"C:\LASERNST\PARTS\PART 123   revB.PRT"  5  

Allow group to span sheets 

If this option is selected, the individual parts of a group may not be placed all on the same 
sheet.  If this option is not selected, then all of the parts for a group will be placed on the 
same sheet. 

Allow parts outside group 

This option allows parts in a group to be nested individually (outside the group). 

 

Structured Groups 
The following is a picture of a structured group: 

 

To create a structured group, click on the Structured Group checkbox.   A drawing of the 
current layout is shown in the bottom of the window.  The overall dimensions of the group are 
shown in the status bar at the bottom of the window. 

To change the layout of a group just move the mouse cursor over a part, press the left mouse 
button and hold it down, and drag the part to a new location.  Release the left button when 
the part is in the proper location. 
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To rotate a part, follow the same procedure except hold down the ALT key in addition to the 
left mouse button.  If the mouse is moved upward, the part will rotate counter-clockwise.  If 

the mouse is moved downward, the part will rotate clockwise. The part will rotate in 1° steps.  
Holding down the SHIFT key and the ALT key at the same time will cause the part to rotate in 

30° steps. 

 Note: The software does not check to see if the parts in your group overlap or not.  It is your 
responsibility to make sure the parts do not interfere with one another. 

Adding and deleting parts in a structured group is done in the same manner as in a simple 
group, the only difference being that no quantity is defined for parts in a structured group.  If 
multiple instances of the same part are desired, the part must be added multiple times. 

Break Up Group If Necessary 

This checkbox controls whether the structured group will be broken apart if necessary to 
improve the nesting.  If this is checked, the software will initially try to place as many copies 
of the specified layout as possible, but if the required part quantities haven't been met yet and 
no more complete layouts will fit on a sheet, the structured group will be broken apart and 
individual parts will be nested.  If this box is not checked, the structured group will not be 
broken apart and nested individually. 

Rotation Angle 

This determines the rotation intervals that the nesting software will use to locate the 
structured group.  This is very similar to the "Rotation Angle" in the part editing dialog.   

Grain Direction 

This determines the grain direction for the structured group.  This value overrides the grain 
direction set for the individual parts making up the group. 

 

Create A Structured Group from a Nest Layout 

It is also possible to create a structured group from an existing nest layout.  To do this,  make 
sure the desired Nest Layout is displayed.  Under the “Edit” menu will be a “Create Structured 
Group” selection.  Choose this or right click in the nest layout and choose the “Create 
Structured Group” item from the context menu as shown below: 
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The structured group file will open with the same parts and layout: 
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Nest Files 

"Normal" Nest File 
The CINCINNATI Laser Programming and Nesting software stores nest files with the .NST 
extension.  To create a new nest, select the New menu item under the File menu.  Then 
select "Nest File".  The following window will be displayed: 
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The "tabs" at the top of the window are used to change between the 5 different pages of the 
nest dialog.  The following sections explain each page in more detail. 

Nest Layout 

The Nest Layout page is used to change parameters that determine how the nest is created. 

 

Nesting Direction 

This parameter determines whether parts are nested predominantly in horizontal rows 
(parallel with machine X) or vertical columns (parallel with machine Y).  The "Most Efficient" 
setting trys both ways and uses whichever direction gives the best material utilization.   This 
setting will cause the nesting process to take approximately twice a long since it is trying both 
directions.   

Nesting Corner 

This parameter determines the sheet corner where nesting begins.  "Lower Left" is the 
machine X0,Y0 corner. 

Nesting Method 

The five methods are: 
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Best fit using angle increment - Each part is nested for best fit.  This is usually the fastest 
method and usually generates a very efficient nest. 

 

Grid - Rectangular fit - Parts are nested in rectangular grids with all the parts at the same 
angle.  This option is used primarily to prepare the nest to use a grid macro and thus reduce 
program size on CL-6 and CL-7A lasers. 

 

Grid - True shape fit - Parts are nested either by themselves or paired with themselves in a 
grid like pattern.  This is generally the slowest nesting method but can yield better material 
utilization with some parts. 

 

Opposite Corner – A part is nested in the starting corner, then the next part is nested in the 
opposite corner.  This continues until the sheet is filled.  This can result in more efficient 
nesting for large round parts as shown below.   
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         Opposite Corner Nest       True Shape Grid Nest     

Most Efficient  – This setting will try Best Fit, True Shape Grid and Opposite Corner nesting 
and use whichever is most efficient for the current sheet.  Rectangular grid is not tried 
because it never gives the most efficient nest.   

Nesting Order 

This parameter determines the order of nesting of different parts with the same priority.   

Optimization 

The two choices are: 

Maximum material utilization - Nests are created to achieve the highest overall material 
utilization.  The entire combination of sheets is treated as one area for nesting.  For each 
sheet, the software can create a different nest or repeat a previous nest. 

Minimum number of programs - Nests are created to achieve the minimum number of 
different nests, while maintaining the minimum utilization for each.  If the Single Program 
box is checked, the software will try to create a single nest that meets the minimum material 
utilization.  If it cannot, no nest will be created.  

Common Line Cutting 

Parts configured for common line (see part editing, General) will be considered for common 
line nesting when this box is enabled.  This option is only available when the Best Fit nesting 
method is used.  The Minimum Length parameter sets the minimum length of a common line 
segment.  Common line cutting and Parts Nested in Slugs are mutually exclusive. 

Maintain part spacing on non-common edges – This checkbox determines whether or not the 
Part Spacing value (below) is maintained on all edges that aren't common lined with another 
part.  Consider the two common lined parts below: 

 

If the Part Spacing is set to 0.125", the only way Part 1 and Part 2 will be common lined is if 
the "Maintain part spacing on non-common edges" checkbox is not checked, because the 
non common lined edge of Part 1 is closer to Part 2 (0.100")  than the Part Spacing value.  
Clearing this checkbox may result in more common lines being found between parts, 
however this should be done with caution, because it may increase the number of head 
crashes. 

Parts Nested in Slugs 

When this box is checked, parts can be nested inside the cutouts (slugs) of other parts. 

Filler Parts on Last Sheet 

If this box is checked, filler parts will be nested on the last sheet of the nest resulting in better 
material utilization.  If it is not checked, the last sheet will have a larger remnant. 

Create Remnant from Nested Sheet 

If this box is checked, the software will create a sheet remnant file from the last sheet in the 
nest.  After the nest has been completed the operator will be prompted for a name for the 
remnant file. 
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Part Spacing 

This parameter determines the spacing used between parts on the nest.  This does not apply 
to parts that use common line cutting unless the "Maintain part spacing on non-common 
edges" checkbox is checked.  

 

Part List 

The Part List dialog is where parts and or groups are added to the nest.   

 

The top of the dialog shows the current list of parts/groups.  The list can be sorted by any of 
the columns by double clicking on any of the title of the column.  

The Order # field is an optional text field that can be used to give more information about a 
part.  This information will be included in the NC code and the report files. 

The Min Qty field determines the minimum desired quantity of the part.  

The Filler column is used to enter is the number of parts that will be added to the nest if 
space permits. 

The Priority field is used to control the order of nesting.  The priority can be between 1 and 
99 with 99 being the highest priority.  Higher priority parts are nested before lower priority 
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parts.  Note: Setting different priorities for parts can have a significant effect on nesting 
efficiency.  Equal priorities should be used whenever possible. 

If the Preview Part checkbox is checked, the bottom of the dialog is used to show a picture 
of the current selected part. 

Add 

This button is used to add a part or group to the part list.  Pressing it will display the following 
dialog: 

 

The "Files of type" list box determine whether a part or a group is going to be added. 

If the Preview part checkbox is checked, a picture of the selected part will be shown in the 
lower right corner of the dialog and the part dimensions and material will be displayed in the 
lower left corner.  If any setup notes are defined for the part, they will be displayed in this 
area also. 

Multiple parts can be added to the nest by selecting multiple files in this dialog.  Once the 
part(s) have been selected, press the OK button. 

Delete 

This button is used to delete the selected part/group from the part list 

Edit Part 

This button is used to open the selected Part file for review or editing.   

Import Part List 
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This button is used to import a text file or XML file into the part's list.   

Text File Format 

The text file must consist of 4 columns per line and one line for each part in the list.  Spaces 
or tab characters should separate the columns.    This file must be in the following format: 

PartName1      Quantity1     Filler1    Priority1 

PartName2      Quantity2     Filler2    Priority2 

etc. 

Note: The part name in the file should include the entire pathname.  In addition, the part 
name must be enclosed in double quotes (") if the pathname contains space characters.  

Example: 

C:\LASERNST\PARTS\PART1.PRT  10   0  5 

"C:\LASERNST\PARTS\PART  103  rev3.PRT"  10   0  5 

XML File Format 

The following is a sample XML part list that contains 2 parts and 1 group file: 

<PartList> 

<Part Name="D:\LaserNst\parts\holes.prt" Quantity="3" Filler="1" Priority="1"/> 

<Group Name="D:\LaserNst\parts\group1.grp" Quantity="3" Priority="1" /> 

<Part Name="D:\LaserNst\parts\testPart.prt" Quantity="13" Filler="0" Priority="5"/> 

</PartList> 

Sheet List 

The parts for a production order can be nested on a series of different sheets.  The sheet list 
may contain rectangular sheets of different sizes and different remnant names.  The 
maximum number of sheets is 900.   



 

124  ••••  Nest Files Laser Programming and Nesting 

 

The Sheet Name column shows the name of sheet or remnant.  Rectangular sheets are 
given a name that shows the overall sheet size. 

The Quantity column determines the available quantity of this sheet.   

The Grain column sets the grain direction of the sheet.  The 3 choices are None, X 
(Horizontal), or Y (Vertical).   

Add 

This button is used to add a sheet to the sheet list.  Pressing it will display the following 
dialog: 
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The list box at the top of the dialog determines whether a rectangular sheet, remnant sheet or 
default sheet is going to be added. 

If a rectangular sheet is being added, the Length and Width of the sheet are entered. If a 
remnant sheet is being added, the name of the remnant file is entered.  A remnant file is 
created either through converting a CAD file or automatically by the software after nesting 
when the "Create Remnant from Nested Sheet" option is selected.  

Default sheet sizes can be entered by pressing the Configure default sheets button.  The 
following dialog will appear: 

  

Default sheets need to be enabled for each material type.  If a default sheet is not enabled for 
a particular material, that sheet will not show up in the “Add/Edit Sheet” dialog if that material 
is specified for the nest. 

 

 

Once all the values have been entered, press the OK button to close the dialog and add the 
sheet to the sheet list. 

Delete 
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This button is used to delete the selected sheet from the sheet list 

Boundaries 

The button is used to define clamp zones and sheet edges for a sheet.  Pressing this button 
displays the following dialog: 

                  

The Distance from Sheet Edges values can be used to keep parts away from the edges of 
a sheet.  If the sheet is rectangular, 4 separate values can be entered.  If a sheet is a 
remnant, only 1 value is entered and it applies to all sides of the remnant. 

The Sheet Clamp Zones define rectangular areas in which the nesting software will not 
place parts.   These will default to whatever values are programmed in the Machine 
Configuration, however they can be overridden in this dialog.   Up to 25 different clamp zones 
can be specified. 

Import List 

This button is used to import a list of rectangular sheet sizes from a text file or XML file.   

Text File Format 

The text file must consist of 4 columns per line and one line for each sheet in the list.  Spaces 
or tab characters should separate the columns.    This file must be in the following format: 

SheetLength1      SheetWidth1     Quantity1    GrainDirection1 

SheetLength2      SheetWidth2     Quantity2    GrainDirection2 

etc. 

Example: 

96.0 48.0 2 N 

88.0 36.0 1 X 
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The above example would add two 96”x48” sheets with no grain direction and one 88”x36” 
sheet with X grain direction. 

XML File Format 

The following is a sample XML sheet list that contains 3 sheets: 

<SheetList> 

<Sheet Length="2400" Width="1200" Units="Metric" /> 

<Sheet Length="48" Width="24" Grain="x" /> 

<Sheet Length="48" Width="24" Quantity="4" Grain="y" /> 

</SheetList> 

 

Material 

This displays the name of a material and thickness combination in a drop-down list.  The list 
of materials is maintained in the Configuration window. This entry is used to check 
compatibility with all the parts in the part list and is used when posting the CNC program. 

Unlimited Sheet Quantities 

If this is checked, then the quantity column above will be blanked and each sheet entry will be 
treated as having an unlimited quantity. 

Automatically Select Best Sheet Size 

If this checkbox is checked and the sheet list has more than one entry, the software will try 
nesting all the parts on all the different entries in the list.  It will use whichever sheet size 
gives the best average material utilization.   

Best Size for Each Layout 

If this is checked, each layout can use a different size for each layout.  For instance, the first 
layout may use a 120”x60” and the second may use a 96”x48” depending on which gives the 
best material utilization.  If this is not checked, all layouts in the nest will use the same size 
sheet.  Checking this may give a better material utilization but it can be confusing for the laser 
operator. 
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Cut Sequence 

 

This dialog is used to change parameters that the nesting software uses when it determines 
the cutting sequence of a nest. 

Cutting Direction 

This value determines whether the overall cutting sequence of parts is horizontal or vertical.  
The "Most Efficient" setting will try both directions and use whichever results in the least 
amount of rapid traverse distance. 

Cut Starting Corner 

This determines the corner that the cutting sequence will start.  "Lower Left" is the machine 
X0,Y0 corner.  The "Most Efficient" setting will try all four corners and use whichever results 
in the least amount of rapid traverse distance. 

Cutting Style 

This parameter specifies whether the overall cutting sequence is in one direction (Continuous 
direction) or goes back and forth (Alternating direction).  The "Most Efficient" setting will try 
both methods and use whichever results in the least amount of rapid traverse distance. 

The "Alternating Parts" setting is similar to the "Continuous direction" selection except that 
afterwards, all the odd numbered parts are cut first and then all the even numbered parts are 
cut.  This gives the effect of cutting every other part which can be useful to reduce heat build 
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up when cutting thicker materials.  The following pictures show the same nest with both the 
"Continuous direction" cutting style and the "Alternating Parts" cutting style: 

 

 

 Note: The "Alternating Parts" setting does not affect the sequencing of parts posted using 
the "Grid Macro" option.  These parts will use the normal grid sequence. 

Plastic Coated Material 

When cutting PVC coated stainless steel, it is often useful to etch through the PVC coating 
before actually cutting the part.  This is necessary to give the assist gas someplace to vent 
and prevent the PVC coating from "bubbling up".   

 

Two different methods are provided for etching through the PVC: 

Etch entire part: If this option is selected, the entire part including interior cutouts will be 
etched first, to melt through the plastic coating.  After the part has been etched, it will be 
cutout using the normal cutting parameters.  Subroutines will be used for the part geometry 
so that program size will be minimized.  

Etch vent hole:  This option just etches a circle of the specified diameter, centered at the 
pierce location before each pierce in the nest.   It is assumed that the hole is of a small 
enough diameter so that the head will not travel over any previously cut features while it is 
etching the vent hole. 

The "Process" field determines which process parameters are used to do the etching. 
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If the “Raise head before cutting” option is selected, an M47 will be posted after the outline 
is etched before the rapid to begin cutting.  This is only available with the “Etch entire part” 
option. 

The “Plastic Coated Material” option is not available if the “Complete all pierces before 
cutting” option is selected. 

Auto slug cut up 

If this option is checked, the slugs in the part will be cut into strips in either the X direction, Y 
direction or both, before the slug is cut out.  This can help ensure that slugs do not tip and 
that they fall through the slats of the laser easily. 

 

If the rectangular box that encloses a slug is either smaller than the minimum dimension or 
larger than the maximum dimension, it will not be cut up.  Slugs whose dimension fall 
between these limits will be cut into strips no larger than the minimum size.   

The Distances from slug outline controls how close the slug cut lines are from the outline of 
the slug.  The pierce distance controls how close the pierce point of the slug-cutting path is 
from the outline.  A setting of 0.00 will pierce on the outline.  The end points value controls 
how close the slug cut line will come to the outline of the slug.   

If a slug has one or more tabs programmed for it, it will not be considered for slug cut up.  
Also if a slug has a part nested inside of it and that part outline has one or more tabs 
programmed, the slug will not be cut up. 

Etch ID string 

This option can be used to etch identifying text on a corner or edge of each sheet.    Press 
the Settings button to change the size and location of the text: 
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The “Text” field is used to enter text to be etched.  This field can be blank if the “Etch nest 
name” field is checked.    Both fields can also be used at the same time.  In this case, the 
Text field will be etched first, followed by the nest name.  If a nest has multiple layouts, the 
layout number is automatically added to the end of the ID string. 

The other fields control the height, font, process and location of the ID string.   The Etch 
location combo box controls which corner or edge of the sheet the ID is placed.   

IMPORTANT NOTE: The reserved width must be large enough to contain all the text, 
otherwise the etched text may overlap a part on the sheet.   

Complete All Pierces Before Cutting 

If this option is checked, all of the pierces on a sheet will be done before any of the parts are 
cut out. This is sometimes useful to reduce heat buildup.  This option is not available if the 
PVC etch option is being used. 

Note: It is not possible to use incremental mode when posting programs that use “The 
complete all pierces before cutting” option.  The posted program will always use absolute 
mode regardless of the Coordinate System setting on the Common Posting Options – 1 
configuration page. 

The Raise head between pierces option can be used to insert a head raise (M47) after each 
pierce, before the rapid move to the next pierce location.  This will result in a slower nest 
although it can reduce tip touches and head crashes. 

The Within part only option controls whether all pierces are done on the entire sheet first or 
just all the pierces for a part.  If this is checked, all the pierces for a part will be done and then 
the part will be cut out before the next part is started. 

The Rapid Pierce Only option controls whether all pierces are done first or only rapid 
pierces.  If this checkbox is checked, only rapid pierces will be done first. 

The Cycle Stop (M00) after pierces option can be used to add a Cycle Stop command after 
all the pierces are completed.  This gives the laser operator an opportunity to clear any debris 
created from the pierce process from the sheet before cutting begins. 

Ignore part tabs 

If this is selected, all tabs programmed for all parts in the nest will be ignored when the NC 
code is generated.  

Complete all etching before cutting 
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If this is selected, all etched features on the nest layout will completed before any cutting is 
done.  This option can not be selected if the Plastic Coated Material checkbox is selected. 

Sheet Cutoff 

It is sometimes useful to cut the sheet skeleton into smaller pieces so that it can be more 
easily removed from the machine after the nest has been cut.  The "Divide Skeleton" option 
allows this to be done. 

Cutoffs can be made Parallel to the X Axis (horizontally), Parallel to the Y Axis (vertically), or 
both.  The "Maximum X dim." and "Maximum Y dim." fields determine where automatic cuts 
will be placed after the nest is created. 

If the "Divide before nesting" option is checked, the software divides the sheet before any 
parts are nested on it.  This ensures that the skeleton cuts will travel the full length or width of 
the sheet without intersecting any nested parts.  If this option is not used, the skeleton cuts 
will stop and start wherever the cut intersects a nested part. 

The "Distance from sheet edge" determines how far beyond the sheet edge the skeleton 
cuts are made.  A positive distance is outside of the sheet and a negative distance is inside of 
the sheet. 

The "Distance from part edge" determines where the sheet cutoffs start/end in relation to 
edges of parts they may intersect.   The default value of 0.0 means that the sheet cutoffs start 
and stop in the kerf of any parts they may intersect.  A positive number can be entered here 
to make the cutoffs to start and stop a short distance from the part edge  if part marking is a 
concern. 

The "Process" field determines which process parameters are used to make the skeleton 
cuts. 

The "Ramped Start" and "Ramped End" fields allow the user to add Ramped Starts and 
Ramped Ends to the cutoff moves.  More information about ramped starts/ends can be found 
in the "Ramped Start/Ends" section of the Part editing dialog. 

The "Optional Gas" checkbox is used to insert a M67 (optional gas pressure) command after 
the pierce on all cutoff moves.  

The "Optional Standoff" checkbox is used to insert a M45 (optional standoff) command after 
the pierce on all cutoff moves. 

The order of M67/M45 and ramped starts can be changed with the “Do ramp before 
M67/M45” checkbox. 

The "Disable Antidive" checkbox is used to insert a M130 command after the pierce on all 
cutoff moves. 

The "Sequencing" field determines when the cuts are made.  The possible choices are: 

Before parts  - Skeleton cuts are made before any parts are cut. 

After parts immediately - Skeleton cuts are made immediately after the last part is cut. 

After parts, after Cycle Stop - A M0 (Cycle Stop) is posted after the final part on the sheet 
causing the program to stop before the skeleton cuts are made.  This gives the operator the 
opportunity to remove any parts that may have tipped or slid under the skeleton before the 
skeleton cuts are made. 

After parts, after 2 pallet cycles - Two M50 commands are posted after the final part on the 
sheet.  The first M50 moves the cut sheet out to the load position so that the cut parts can be 
removed before the skeleton cuts are made.  The second M50 moves the cut sheet back into 
the cut position so the skeleton cuts can be made.  

 



 

Laser Programming and Nesting Nest Files  ••••  133 

Manual Editing 

Skeleton cuts can be manually added by clicking the right mouse button in the Nest View and 
selecting the "Add Sheet Cutoff(s)" option.  Drag the cutoff line to the desired location and 
click the left mouse button to add a skeleton cut. 

Skeleton cuts can be deleted by clicking on the cut first, then pressing the right mouse button 
and selecting the "Delete cutoff" option.  The "Edit cutoff" option allows the process and start 
of cut to be changed for each skeleton cut if desired. 

 

Use of Variables 

If the sheet being cut is rectangular, system variables #120 and #121 are used in the posted 
NC code to represent the sheet width and sheet length.  These variables are initialized in the 
NC code to the sheet dimensions entered on the Sheet List page.  If the actual sheet size 
used is slightly larger or smaller, these variables can be edited at the machine to ensure that 
the sheet cutoffs cut the entire sheet. 

Summary 

 

The summary page is used to get a quick overview of the nesting results.  The top half of the 
page gives the part summary and the bottom is used for the sheet summary. 



 

134  ••••  Nest Files Laser Programming and Nesting 

Part Summary 

The total number of parts nested on all sheets is shown here.  The Req column shows the 
requested number of each part (Min Quantity on Part List page), the Actual column shows 
the total number of parts nested on all sheets, and the Diff. Column is the difference between 
the Requested and Actual fields.  Negative difference values indicate a shortage of parts and 
displaying them in red further highlights those lines.  

Sheet Summary 

This area shows the total number sheet used along with the percent utilization for each sheet. 

 

Grid Nest File 
Grid Nest files are similar to "normal" nest files except that the user specifies the locations of 
all parts on the sheet.   A rectangular grid of parts can be entered or just single parts.   

This can be useful when an exact user specified layout is desired or to interface with other 
software.  The CINCINNATI Laser Programming and Nesting software stores grid nest files 
with the .GRD extension.  To create a new grid nest, select the New menu item under the 
File menu.  Then select "Grid Nest File".  The following window will be displayed: 

 

The "tabs" at the top of the window are used to change between the 2 different pages of the 
grid nest dialog.  The following sections explain each page in more detail. 
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Part List 

The Part List dialog is where parts are added to the grid nest.  Groups cannot be added to a 
grid nest.   

 

The top of the dialog shows the current list of parts.  The list can be sorted by any of the 
columns by double clicking on any of the title of the column.  

The X Loc. and Y Loc.  fields determines the location of the part in the upper right corner of 
the grid.  

The Angle column is used to rotate the part when it is placed on the nest. 

The Rows and Columns fields determine how many parts are in the grid.  To nest a single 
part, both the Rows and Columns field should be set to 1.   

The X Inc. and Y Inc.  fields determine the spacing of the parts in the grid.  These values are 
ignored for single parts. 

The following example is a  3 row by 4 column grid: 
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Add, Delete, Edit Part 

These buttons are used to add, delete and edit parts in the parts list.  They function exactly 
the same as with a normal nest file. 

Import Part List 

This button is used to import a text file into the part's list.  The text file must consist of 7 
columns per line and one line for each part in the list.  The columns should be separated by 
spaces or tab characters.    This file must be in the following format: 

PartName1      XLoc1    YLoc1    Angle1   Rows1    Cols1    XInc1    YInc1  

PartName2      XLoc2    YLoc2    Angle2   Rows2    Cols2    XInc2    YInc2  

etc. 

Note: The part name in the file should include the entire pathname.  In addition, the part 
name must be enclosed in double quotes (") if the pathname contains space characters.  

Example: 

C:\LASERNST\PARTS\PART1.PRT    115.0  52.0 0 2 5 23.0  19.5 

"C:\LASERNST\PARTS\PART  103  rev3.PRT"  115.0  32.0 0 1 6 17.0  12.0 
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Cut Sequence 

 

This dialog is used to change parameters that the nesting software uses when it determines 
the cutting sequence of a nest.  It is very similar to the Cut Sequence page of the Normal 
Nest File, only the differences will be described here. 

Material 

This displays the name of a material and thickness combination in a drop-down list.  The list 
of materials is maintained in the Configuration window. This entry is used to check 
compatibility with all the parts in the part list and is used when posting the CNC program. 

Sheet Dimensions 

The sheet dimensions are used when displaying the nest and to command sheet cutoff 
lengths if the Divide Skeleton checkbox is checked. 

Number of copies 

This field is used to specify how many copies of the grid layout will be cut.   The default value 
is 1. 

Note – The software does not check to make sure the parts as specified by the user lie 
on the sheet.  It is the users responsibility to insure that the locations given for the 
parts are within the sheet boundaries. 
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Creating a Nest 
Once all the parts and sheets have been added to the nest, the Create Nest button is 
pressed to generate a nest.  A view window will appear which shows the nest as it is being 
created.  A status window is also displayed which shows the current nesting status.  The 
Cancel button can be pressed at any time to abort the nesting process. 

 

 

If the nesting process is successful, the View Nest and Create NC buttons will be enabled at 
the bottom of the nest window.  If no nest is found or the process is aborted, the buttons will 
be disabled. 

Viewing a Nest 
If the View Nest button is enabled, a valid nest exists and can be viewed.  Press the View 
Nest button and the following window will be displayed: 
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If more than one sheet was created, the Previous and Next buttons will be enabled and can 
be used to switch between sheets.  The part list on the upper right corner shows the parts 
and quantities nested on this sheet.   

The  display can be zoomed to view the nest in more detail by using any of the zoom tool bar 
buttons or selecting a zoom option under the View menu.  The nest can also be printed 

The nest can also be printed by selecting Print… under the File menu or clicking on the 

printer icon on the toolbar:    

The Display process colors option will display all parts in the nest using a different color to 
represent each process in the part.  The colors used will be the same used in the Process 
editing part dialog. 

The Sequencing button can be used to show the cutting sequence of the nest. Pressing it 
changes the display to the following window: 
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The numbers inside of the parts show the cutting sequence that will be used for the sheet.  
Rapid moves between parts are shown with orange lines.  If more than one sheet was 
created, the Previous and Next buttons will be enabled and can be used to switch between 
sheets.    

The Animation Control section is used to animate the cutting sequence.  Press the Play 
button to start the animation.  The animation speed is controlled by the slider control on the 
right side and the "by Feature" and "by Part" radio buttons.  The "by Feature" selection 
causes each feature to be drawn by itself whereas the "by Part" selection causes the entire 
part to be drawn at once.  

The Auto Seq button is used to regenerate the cutting sequence.  This can be used in 
conjunction with the Cut Sequence page of the Nest window to experiment with different 
sequencing options. 

Manual editing of the cut sequence is possible by selecting a part while in the sequence view 
with the left mouse button.  The following dialog will be displayed: 

                     

 
Enter the new sequence number for the part and press the OK button.  The sequence 
numbers for the rest of the parts on the sheet will be renumbered automatically. 
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The cutting sequence of the entire nest can be manually changed easily by pressing the 
Resequence button.  After the Resequence button is pressed, select the parts one at a time 
in the desired cutting sequence, starting with the first.  To start resequencing at some other 
point, hold the shift key down while selecting the desired starting part.  For example, if a nest 
has 30 parts and the cutting sequence is OK for the first 25 parts, hold the shift key down and 
select the 25

th
 part.  Then select the remaining 5 parts in the desired cutting order. 

The Part List button returns to the previous nest view. 

Manual Nesting 
Manual editing of the nest layout is possible.  Parts can be moved, rotated, mirrored, added 
or deleted.  Entire layouts can be added, deleted or copied and the number of repeats for 
each layout can be changed.   To edit a nest layout, make sure the normal view of the nest is 
displayed (the part list should be displayed in the upper right corner) 
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To move a part:  Move the mouse cursor over a part, press the left mouse button and hold it 
down, and drag the part to a new location.  Release the left button when the part is in the 
proper location. 

If the space bar is held down while the part is moved, it will not move within the part spacing 
value of any other parts or the sheet edges.  If the part is already within this distance and the 
space bar is held down, the part will not move at all. 

 Part(s) can also be moved by selecting them and then using the incremental move buttons 
on the toolbar: 

 

The dropdown list box is used to select the incremental move distance. 

To rotate a part:  Follow the same procedure except hold down the ALT key in addition to the 
left mouse button.  If the mouse is moved upward, the part will rotate counter-clockwise.  If 

the mouse is moved downward, the part will rotate clockwise. The part will rotate in 1° steps.  
Holding down the SHIFT key and the ALT key at the same time will cause the part to rotate in 

30° steps.  Parts can also be rotated in 15° increments by selecting them and then using the 
incremental rotate buttons on the the toolbar: 

 

To add a part: Either select the "Add Part" item under the Edit menu or press the right mouse 
button in the nest view and select the "Add Part" item from the pop-up menu.  The following 
dialog will be displayed: 

                          

You can select any part that was in the original part list for the nest.  To select a part that 
wasn’t in the original part list, press the Browse button to select a new part or group.  Press 
OK after the part is selected and the part will be added to the nest.  It can now be moved to 
it's desired location using the techniques described above.  
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To mirror a part:  Select the part to mirror by left clicking on it with the mouse.  It should be 
highlighted.   Either select the "MirrorPart" item under the Edit menu or press the right mouse 
button in the nest view and select the "Mirror Part" item from the pop-up menu.  A mirror 
image of the part will replace the original part. 

To copy a part:  Select the part to copy by left clicking on it with the mouse.  It should be 
highlighted.   Either select the "Copy Part" item under the Edit menu or press the right mouse 
button in the nest view and select the "Copy Part" item from the pop-up menu.  Another copy 
of the selected part will be placed on the sheet. 

To delete a part:  Select the part to delete by left clicking on it with the mouse.  It should be 
highlighted.   Either select the "Delete Part" item under the Edit menu or press the right 
mouse button in the nest view and select the "Delete Part" item from the pop-up menu.  The 
selected part will be removed from the sheet. 

When parts are added to a nest layout, they are added to the end of the cut sequence.  It 
may be necessary to manually edit the cut sequence or regenerate the sequence after the 
nest is edited.   

Undo Changes: To undo any changes made to a nest layout, either press the undo button on 

the toolbar:  , or press the CTRL key and the Z key at the same time.  You can 
undo the last 30 changes made to a nest layout. 

Multiple Selections – You can also move, rotate, copy and delete multiple parts at one time.  
To select multiple parts you can either hold the left mouse button down and drag the window 
around the desired parts or hold the CTRL key down while clicking on the individual parts. 

To add  a new layout – Select the “Add New Layout” item under the Edit menu or the right 
click menu.  If multiple sheet sizes are specified for the nest, the user will be prompted to 
select the sheet size to use for the new layout. 

To delete a layout – Select the “Delete This Layout” item under the Edit menu or the right 
click menu.  This will delete the current layout from the nest.  Note: Each nest must contain at 
least one layout so you cannot delete the last layout of a nest. 

To change the order of  the layouts – Select the “Change Layout Number” item under the Edit 
menu or the right click menu.  This allows the layout number of the current layout to be 
changed. 

To copy a layout – First make sure the layout to be copied is displayed in the nest view, then 
select the “Copy This Layout” item under the Edit  menu or the right click menu.  A new layout 
will be created with the same parts placed on it as the original. 

To change the number of repeats for a layout – First select the proper layout in the nest view 
and then select the “Change Number of Copies” item from the Edit menu or right click menu.    
The user can change the number of copies to any number between 1 and 999.  

Sheet cutoff editing 
It is possible to modify the sheet cutoffs automatically added during the nesting process.  
Existing cutoffs can deleted or trimmed and additional cutoffs can be added. 

Adding cutoffs 

Additional cutoffs can be added by right clicking the mouse in the Nest View and selecting the 
“Add Sheet Cutoff(s) option.  Drag the cutoff line to the desired location and click the left 
mouse button to add a new skeleton cut.  Pressing the middle mouse button will toggle the 
cutoff direction.  When done adding cutoffs, press the ESC key. 



 

144  ••••  Nest Files Laser Programming and Nesting 

 

Deleting cutoffs 

To delete a cutoff, click on the cutoff first and it will be displayed in green (selected color).  
Then press the right mouse button and select the “Delete cutoff” option.   

All pieces of a particular cutoff can be deleted in one step by choosing the “Delete cutoff (all 
segments)” option.  This will delete all pieces of a cutoff even if they are seperated by parts in 
the layout. 
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Trimming cutoffs 

It is also possible to trim a cutoff where it intersects another cutoff.  For example, to trim the 
horizontal cutoff in the nest below where it extends through the large uncut section, right click 
in the nest view.  Select the “Trim cutoff” option and then click on the piece of the cutoff that 
is to be deleted: 
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The following picture shows the horizontal cutoff after the right side has been trimmed off: 
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After Triming one cutoff, the software will remain in “Trim” mode until the ESC key is pressed. 

Generating NC Code 
NC code can be generated from a valid nest by pressing the Create NC button at the bottom 
of the nest window.  The following dialog will be displayed: 
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The name will default to the nest name with a .CNC extension. 

The Use layouts list box in the bottom left corner can be used to ignore layouts when 
generating the NC code.  All layouts are selected by default when the dialog is first opened. 

The Comments field can be used to add setup notes or other information that may be useful 
for the operator. 

CL6 and CL7A only : The Program number, Starting sheet subroutine, and Starting part 
subroutine determine what numbers will be used for each of these values.  These will 
automatically increment after the NC code is generated. 

After the NC code is created, the NC file is opened in a text editing window to review or edit. 

The structure of the NC code that is generated is configured using  the Posting Options 
pages in the configuration. 

Probe Hole Locations 

If the optional Optical Probe is being used with the Align to Holes macro, the following dialog 
will be displayed so that the location of the probe holes can be verified and/or changed: 
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Any preprocessed features will displayed in green and laser cut features will be displayed in 
gray.  The current probe locations are shown with blue crosses and the range of nozzle 
motion is shown with orange crosses.  It is up to the user to insure that the nozzle motion 
occurs over the sheet and does not occur over a preprocessed feature. 

If the nest contains any preprocessed holes, they can be selected for the probe holes.  When 
a preprocessed hole is selected, the software will move the closest existing probe hole to the 
new location.  Alternatively, the probe information can be entered manually into the edit 
boxes.   

When the user is satisfied with the probe locations, they should press the OK button to 
continue creating the NC code. 

Plotting NC Code 
A tool path plot can be generated for any NC file by selecting Plot NC File under the File 

menu or selecting the Plot icon on the toolbar:  

 

If no syntax errors exist in the program, the following window will be displayed: 
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Rapid moves with the head down are shown in dark blue, rapid moves with the head up are 
shown in light blue, and contouring moves are shown in red. 

If any errors are found in the CNC program, an error message will be displayed and the 
cursor will be placed on the line that contains the error. 

The Next and Prev buttons can be used to switch between sheets.  The plotting software 
uses M50's to determine when one sheet ends and the next begins.   

NOTE:  The Estimated Run Time does not contain the time for M50's (pallet exchanges).  
The software assumes that the pallets are in position and the machine is ready to run.  

Pressing the button which displays the Estimated Run Time will display a dialog which shows 
details on the estimated run time: 
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The plotted NC program may or may not include cutter compensation depending on the 
setting of the Include cutter compensation when plotting NC code option on the 
Preferences configuration page. 

Exporting DXF/DWG files 

It is possible to export a NC file plot as a DXF or DWG drawing file by selecting the Export 
CAD File option under the File menu when a NC plot is displayed.  It is recommended that 
cutter compensation be turned off before this is done (see above) so that the drawing file 
created contains the actual part dimensions and not the compensated dimensions. 

 

Viewing a Report 
A report file is generated when the NC code is created.  This report file has the same name 
as the NC file except with either a “.RPT” or a “.report.XML” extension depending on whether 
the report type is configured for Plain Text or XML.  The report type along with other features 
of the report file can be changed using the Production Report page of the configuration. To 
view the report, press the View Report button. 

A sample report is shown below: 

 

Sample Reports 
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    Sample Plain Text Report File 
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     Sample XML Report file       

Fixture Nest File 
Some laser system users have mounted special fixtures on the pallets to hold multiple sheets 
of material.  For example, the picture below shows eight 24” square sheets of material placed 
on a 5’x10’ frame.   Fixture Nest files are a special type of nest file used to create NC files for 
these multiple sheets of material.  

The CINCINNATI Laser Programming and Nesting software stores Fixture Nest files with the 
.FXT extension.  To create a new fixture nest, select the New menu item under the File menu 

and then select "Fixture Nest File" or select the New Fixture Nest icon    on the menu bar.  
The following window will be displayed: 
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Guidelines 

The following guidelines apply to fixture nest files: 

• Each sheet of material is limited to a single part file or structured group file.   
Multiple parts/groups cannot be placed on a single sheet. 

• An error will be reported if a part/group is too large to be placed on a sheet.    

• Parts are placed on a sheet with the same orientation used in the part file.  There 
is no ability to rotate the part on the sheet. 

• Each sheet of material on the layout must be rectangular and have the same 
dimensions. 

• The material for each sheet can be different if desired.  

• A part does not need to be assigned for each sheet.  Blank sheets will be ignored 
when the NC file is created. 

• The cut sequence of the sheets cannot be changed.  The sheets are always cut 
in order. 

   

Fixture Properties 

To change the number or size of the sheets press the Properties button at the bottom of the 
Fixture Nest.  The following dialog will be displayed: 
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Template 

Templates control the layout of the sheets.  The user can create as many templates as 
desired by pressing the Edit Templates button.  To change the template used for the current 
file, pick one of the available templates from the listbox.   

Part Location 

The location of the part on the sheet is controlled with this selection.  The choices are to: 1) 
center the part on the sheet , 2)offset the part from the Xmin, Ymin corner of the sheet or 3) 
offset the part from the Xmin and Y edge that is closest to the edge of the machine.  For 
example, when using the third choice, the parts would be located as shown below: 
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Head Raise Distance 

This setting controls the distance the z-axis will raise before moving between sheets.  This 
distance must be set high enough so the cutting head does not hit any fixturing mounted on 
the pallet. 

Template Editing 

This dialog is used to create new templates or edit existing ones. 
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When the number of rows or columns is changed, the corner location for each of the sheets 
will be automatically calculated to evenly distribute the sheets on the pallet.   These should 
be changed as necessary to match whatever fixtures are used to hold the sheets to the 
pallets. 

The Description field can be used to include comments to the operator regarding the 
fixtures.  This field will be included as comments at the beginning of the NC file. 

Adding Parts 

To add parts to a fixture nest file, just click on a sheet.  The following part selection dialog will 
appear: 
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This dialog shows a preview of the selected part and it contains two controls unique for 
Fixture Nests. 

Selecting Parts or Groups 

To choose between adding a single part or a structured group, change the “Files of type” 
combo box to either “Part Files (*.prt)” or “Group Files (*.grp)”.   

Material 

This control allows the user to override the material used for the part.  The default value is the 
material assigned in the part file. This allows the same part geometry to be used for several 
different materials. 

Fill Remaining Sheet(s) with this part 

If this checkbox is checked when the OK button is pressed, this part will be assigned to all 
sheets that don’t have a part already assigned to them. 
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Nest Editing 

The following is a fixture nest with seven of the eight sheets filled.   

 

The nest can be edited by right clicking on a sheet.   

Delete Part – This deletes the part from the current sheet only.  Other copies of the same 
part located on other sheets will not be affected. 

Copy Part - This copies the current part name and material so it can be pasted to other 
sheets later. 

Paste Part – This option is enabled if a part has previously been copied and is used to paste 
the same part onto a different sheet 

Edit Part – This will open the current part file up in a normal part editing window. 

NC Code 
 When the Fixture Nest is complete, the Create NC button is used to create NC code to run on the laser 

system.  The code will contain comments at the beginning of the program to instruct the 
operator about the template used, the sheet size, which material to load at each location and 
which parts will be cut out. 



 

160  ••••  Nest Files Laser Programming and Nesting 
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Manual Repositioning 

Overview 
Sometimes it may be necessary to process material on the laser system that is longer than 
the X axis machine travel.  Manual repositioning allows the operator to run one portion of an 
NC program, re-load the work piece at a new location, and then run the second portion of the 
NC program. 

 

Restrictions: 

• The user accepts the reduced accuracy and/or edge quality possible when the 
process divides a cutting path into two sequences separated by material 
repositioning. 

• The software will only produce NC programs for a maximum of two cutting positions 
per sheet. 

• When the software creates a nest for repositioning, it will not arrange parts for 
common line cutting. 

• The software will not use subprograms for parts on a sheet that uses repositioning 
regardless of the settings of the Program Structure section on the Common Posting 
Options –1 configuration page. 

• Edge detection cannot be used with manual repositioning.  

• The NC program generated for a repositioned sheet will always use the “Absolute 
(G90) with work coordinate system (G92)” coordinate system regardless of the 
setting on Common Posting Options –1 configuration page. 

• Manual repositioning does not work with Grid Nests. 

 

Enabling\Disabling 
The manual repositioning option is enabled on the Machine Config page using the 
Repositioning field.  
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If this is set to None, repositioning is disabled and an error will be generated if a sheet is 
added to a nest that exceeds the X travel limits of the machine.  This should be set to Manual 
(in load frame) or Manual (in main frame) to enable repositioning.   

NOTE:  Repositioning will only be used when necessary, when the sheet length exceeds the 
X travel limits of the machine.   It is not necessary to turn off repositioning to create “normal” 
nests with sheet lengths less than or equal to the travel limits. 

When configured for Manual (in load frame), the first portion of the program stops with a 
M50.  The operator presses the Pallets Not Ready button and the pallet moves to the load 
frame.   After the operator moves the material to the second cut position, he presses the 
Pallets Not Ready button again and a second M50 is executed to move the pallet back into 
the machine frame.  When the pallet is in position, processing resumes and the laser 
completes the second portion of the program. 

When configured for Manual (in main frame), the first portion of the program stops with a 
M0.  The operator then repositions the material and presses Cycle Start.  The processing 
resumes and the laser completes the second portion of the program.   

The Settings button allows parameters related to the Manual Repositioning to be configured. 
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Settings 
The Manual Repositioning Settings dialog is shown below.  

 

Index Distance 

X: This is the X distance that the material moves (relative to the pallet) between cutting 
positions.  The maximum Index Distance is the X travel limit of the machine.   

Y: This can be used to program a known Y-Axis offset in the NC code, however the default 
value of 0.0 should be used in most circumstances. 

The software uses the Index Distance to divide the sheet area into two sections (see below).  
One section extends from X0 to the max travel limit of the machine.  The other section 
extends from the index position to the sheet length.  In the center of the sheet is an area that 
the cutting head can reach with the material at either position. 

 

Maximum Sheet Length 
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This value is the maximum length sheet that can be used with manual repositioning.  It 
should not be greater than the sum of the Maximum X Travel limit and the Index distance. 

Allow divided paths 

When this is checked, the software can nest parts anywhere on the sheet.   The parts can 
have internal or external paths that require a divided cutting sequence.  This must be 
selected to nest parts that are larger than the machine travel limits. 

If this is not checked, the software will only nest a part if it can be completely cut in either of 
above cutting sections.   

Note: The main feature of repositioning is the ability to make parts that cannot fit in the cutting 
area accessible by the machine axes.  To create programs for those parts, the user must 
select “Allow Divided Paths”.  Another feature of repositioning is the ability to process sheets 
of material that are longer than the pallet size.  If no parts require cutting in two positions, the 
laser system may be more productive (considering accuracy and edge quality) with “Allow 
Divided Paths” off.  When the laser system cuts a path using two sequences separated by 
material repositioning, the accuracy and edge quality might not be as good as when the laser 
cuts the path continuously in one material position. 

Begin with.. 

The NC program created for manual repositioning does not control the material location.  It 
relies on the operator to load the material correctly for the program.  The user can configure 
the NC program to begin with the material in either cutting position.  

The NC program will contain a comment near the top, notifying the operator to load the 
material at the expected location before starting the program.  For example: 

( Start program with material X=0.000 aligned with Machine X0  ) 

or 

( Start program with material X=72.000 aligned with Machine X0  ) 

Probe settings 

If the configuration specifies using the Touch Probe or Optical Probe Align to Holes macro, 
this section will be enabled.  The user can specify to use the probe in one, both, or neither 
material position.   When NC code is created, the user will be prompted to select probe hole 
locations for each specified material position. 

 If the “Second material position” option is checked, the “Cut Probe Holes” option will be 
enabled.  This will cut the probe holes at the end of the first section of the program when the 
material is still in the first position.  The center coordinates and diameters of the holes are 
specified on the second probe hole location window.  

Reference lines 

When the configuration does not specify Touch Probe or Optical Probe to measure the 
second material position, the program relies on the Work Offset values to command the 
coordinate system.  Since the manual repositioning process is not likely to locate the material 
exactly at the predicted Index Distance, before running the NC program for the second 
material position, the machine operator can adjust the NC program for the actual material 
position.  To help the operator determine how to edit the X and Y Work offset values, the NC 
program can etch reference lines on the material after cutting in the first position and before 
cutting in the second position.  
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The X and Y values determine the center of the reference lines and the length determines the 
size. The reference lines must lie in an area that is reachable from both material positions 
(the X center value must be between the index distance and the max X travel limit of the 
machine).  It is up to the operator to insure that the etched lines do not interfere with any 
parts on the sheet, preprocessed features, or sheet cutoffs.  The etched reference lines will 
be displayed on the Nest View and NC Plot views to help the operator verify that the general 
location is acceptable. 

After etching the second half of the lines, the machine will stop with a M0 so the operator can 
measure the X and Y errors.  If the error is not acceptable, he can edit the #2502 and #2602 
assignments, edit the program to skip over the first portion, reload and restart the program.  
This can be repeated as many times as necessary.   

To correct the program for the alignment errors shown in the figure above, the variable 
assignments would be increased by the indicated distances.  The variable assignments 
would be decreased for errors in the opposite direction. Each time the program is restarted, it 
will etch a new set of lines at the second position and stop with M0 for another measurement. 

Nesting 
When the software is configured for repositioning and the sheet is longer than the X travel 
limit of the machine, the automatic nesting process follows these steps: 

1. Parts are placed if they can be cut entirely in the first cutting position.  

2. Parts are placed if they can be cut entirely in the second cutting position. 

3. If the “Allowed Divided Paths” option is checked, Parts are placed anywhere on the 
remaining sheet area. 

When manually nesting, it is up to the operator to ensure that manually placed parts do not 
interfere with other parts.  If a part is manually placed where it cannot be cut entirely in one 
position and the “Allow Divided Paths” option is not on, an error will be displayed when NC 
code is created. 

Sequencing 
The following is an example nest showing the part sequencing for a manual repositioned 
nest: 
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Parts that will be cut completely in the first position are displayed in the normal color scheme 
(red and blue).  Parts that will be cut completely in the second position are displayed in 
orange/purple.  Parts that are cut in both positions are displayed in dark blue/brown and have 
their sequence number labeled XX/YY.  The first number is the sequence number of the part 
cut in the first position and the second number is the sequence number in the second 
position.  

If the sequence is manually edited, the software will ensure that the sequence numbers are 
correct for the material position.  For example, the sequence number for Part #2 above 
cannot be changed to 5, it must be between 1 and 4 because there are 4 parts in the first 
cutting position.   

NC Code 
The NC code generated for a nest with manual repositioning has comments to instruct the 
laser operator what to do.   At the beginning of the sheet the following lines will be displayed 
telling the operator how to initially load the sheet: 

( ============================================================ ) 

( Start program with material X=72.000 aligned with Machine X0  ) 

( ============================================================ ) 

 

The following code is from the end of the first section of the program and the beginning of the 
second section.  It shows the reference lines being etched, the M50 to move the partially cut 
sheet to the load frame, the instructions to the operator to reposition the sheet, the M50 to 
move the sheet back into the main frame, the second etching of the reference lines, and the 
opportunity for the operator to make changes.  

( ============================================================ ) 

( Etch reference lines in first position ) 
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( ============================================================ ) 

G89 P MS075N2.lib 

G0X73Y3 

G84 

F#148 

G1Y4G9 

G1X74 

M35 

M42 

M50( Before Reposition ) 

( ============================================================ ) 

( Reposition sheet so material X=0 is aligned with Machine X0  ) 

( ============================================================ ) 

M50( After Reposition ) 

N173G92X#5021Y#5022 

#2502=0.000 (X OFFSET) 

#2602=0.000 (Y OFFSET) 

G55 

( ============================================================ ) 

( Etch reference lines in second position ) 

( ============================================================ ) 

G89 P MS075N2.lib 

G0X72Y4 

G84 

F#148 

G1X73G9 

G1Y5 

M35 

M42 

G0X0Y0 

M0 

( ============================================================ ) 

( Check alignment of reference lines. ) 

( If alignment is OK, press Cycle Start to continue, otherwise: ) 

(  - edit variable assignments 2502 and 2602 as needed above  ) 

(  - edit goto line at the beginning of sheet to line number 173 ) 

(  - reload, and restart program. ) 

( ============================================================ ) 
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Custom Lead In Files 

Creating/Editing 
To create a new custom lead in file select New under the File menu, then select "Custom 
lead in file" from the dialog box.  The following screen will be displayed: 
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The red dot near at the top of the picture represents the pierce location.  The green line at the 
bottom of the picture represents the first segment of the feature with the green arrow 
indicating the cutting direction. 

A custom lead in can contain an unlimited number of arcs and lines at varying feedrates, 
angles, processes and dwells.  To add new segments press either the Insert Before button 
to insert a new segment before the current segment or Insert After to insert a new segment 
after the current segment.  The Delete Current button is used to delete the current segment.  
This is disabled when the lead in contains only 1 segment. 

Type 

This list box is used to change the current segment to a linear move, clockwise arc, or  
counterclockwise arc. 

Sweep 

This is the sweep angle for the arc segment.  This value will not appear if the current 
segment type is Linear. Its range is 1 degree (very small arc) to 360 degrees (full circle). 

Radius (Length) 

This value sets either the radius of the segment for arcs or the length of the segment for 
linear moves. 

Angle 

This is the angle that the current segment of the lead in makes with the next segment.  If the 
current segment is the last segment of the lead in, then this represents the angle made with 
the first vector of the feature. 

Feedrate 

This is the feedrate that will be used for the current segment.  The feedrate can be specified 
as either a percentage of the process feedrate or as an absolute feedrate value specified in 
ipm (or mm / min).   

Dwell 

This value specifies a dwell at the end of the current segment.   

M45 & M67 

These options allow the programming of a M45 (optional standoff) and a M67 (optional gas 
pressure) at the end of the current segment.  Only one M45 and one M67 can be 
programmed per lead in and programming a M45 or M67 during a lead in prevents that M 
code from being used again on a feature which uses the lead in. 

Process 

This is used to set the process type for the current segment.  The process can be changed 
on a segment by segment basis.  If the process changes between segments, the NC code 
will contain an M35 to turn the beam off, a new G89 line to load the new parameters and 
finally a G85 (or G84 T3) to turn the beam back on.  If the process is set to “Default”, that 
segment will use whatever process is programmed for the overall feature.  See the Process 
Type window for information on changing the process type for a feature.  

Notes 

This field can be used to record any notes or comments about the lead in.   Multiple lines of 
text can be entered if desired. 

Prev / Next 
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These buttons change the current segment.  The current segment number is shown at the 
top of the dialog and the current segment is displayed in purple in the drawing of the lead in.  

Saving 
When you are finished with changes to the custom lead in file,  it must be saved.  Use either 
the Save or Save As options under the file menu to save the lead in file.  Custom lead in files 
must end with the .LDN suffix. 
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Custom Lead Out Files 

Creating/Editing 
To create a new custom lead out file select New under the File menu, then select "Custom 
lead out file" from the dialog box.  The following screen will be displayed: 

 

The green dot near the middle of the picture represents the start of the feature.  The green 
line to the right of the green dot represents the first segment of the feature and the green line 
on the left side represents the last segment of the feature. 

A custom lead out can contain an unlimited number of arcs and lines at varying feedrates, 
angles, processes and dwells.  To add new segments press either the Insert Before button 
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to insert a new segment before the current segment or Insert After to insert a new segment 
after the current segment.  The Delete Current button is used to delete the current segment.  
This is disabled when the lead in contains only 1 segment. 

Tabbing  

Tabbing can be accomplished with a custom lead out by entering a non-zero value for the 
“Lead out starts _____ before end of feature” field.  A positive value in this field will make the 
lead out start this distance before the actual end of the feature. 

Type 

This list box is used to change the current segment to a linear move, clockwise arc, or 
counterclockwise arc. 

Sweep 

This is the sweep angle for the arc segment.  This value will not appear if the current 
segment type is Linear. Its range is 1 degree (very small arc) to 360 degrees (full circle). 

Radius (Length) 

This value sets either the radius of the segment for arcs or the length of the segment for 
linear moves. 

Angle 

This is the angle that the current segment of the lead out makes with the next segment.  If the 
current segment is the first segment of the lead out, then this represents the angle made with 
the last vector of the feature. 

Feedrate 

This is the feedrate that will be used for the current segment.  The feedrate can be specified 
as either a percentage of the process feedrate or as an absolute feedrate value specified in 
ipm (or mm / min).   

Dwell 

This value specifies a dwell at the end of the current segment.   

Process 

This is used to set the process type for the current segment.  The process can be changed 
on a segment by segment basis.  If the process changes between segments, the NC code 
will contain an M35 to turn the beam off, a new G89 line to load the new parameters and 
finally a G85 (or G84 T3) to turn the beam back on.  If the process is set to “Default”, that 
segment will use whatever process is programmed for the overall feature.  See the Process 
Type window for information on changing the process type for a feature.  

Notes 

This field can be used to record any notes or comments about the lead out.   Multiple lines of 
text can be entered if desired. 

Prev / Next 

These buttons change the current segment.  The current segment number is shown at the 
top of the dialog and the current segment is displayed in purple in the drawing of the lead in.  
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Saving 
When you are finished with changes to the custom lead in file,  it must be saved.  Use either 
the Save or Save As options under the file menu to save the lead in file.  Custom lead in files 
must end with the .LDN suffix. 

Hardware Lock Troubleshooting 

Overview 
This section describes the installation and basic troubleshooting procedures for the hardware 
key (Hardlock or HASP) provided with the CINCINNATI Laser Programming and Nesting 
software.  

Identification 
The CINCINNATI software requires that a hardware lock be attached to the computer that is 
running the software or, in the case of the Network (Multi-User) lock, to a computer on a local 
network.   There are six types of hardware locks supplied by CINCINNATI:  Single User 
Parallel Port Hardlocks, Single User USB Hardlocks, Network Parallel Port Hardlocks, 
Network USB Hardlocks, Single User USB HASP’s and Network USB HASPs.  The Hardlock 
devices were supplied prior to 2007 and HASP devices have been supplied from 2007 to the 
present. 

Single User Parallel Hardlock 

 

This device is black in color and plugs into the parallel port of the local computer. 

 

Single User USB Hardlock 
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This device is blue in color and plugs into a USB port of the local computer.  It has a LED 
inside which should light up when the device is plugged in and the proper drivers are 
installed.  The plastic portion of the lock is approximately 1½ inches long. 

 

Network Parallel Port Hardlock 

 

This device is pink on one side and blue/green on the other.  It plugs into the parallel port of a 
networked computer and allows up to 10 client computers to connect to the lock and run the 
CINCINNATI software. 

 

Network USB Hardlock 

 

This device is green in color and plugs into a USB port of a networked computer and allows 
up to 10 client computers to connect to the lock and run the CINCINNATI software.  It has a 
LED inside which should light up when the device is plugged in and the proper drivers are 
installed.  The plastic portion of the lock is approximately 1½ inches long. 

 

Single User USB HASP 

 

This device is green in color and plugs into a USB port of the local computer.  It has a LED 
inside which should light up when the device is plugged in and the proper drivers are 
installed.  The plastic portion of the lock is approximately 1 inch long. 
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Network USB HASP 

 

This device is red in color and plugs into a USB port of a networked computer and allows up 
to 10 client computers to connect to the lock and run the CINCINNATI software.  It has a LED 
inside which should light up when the device is plugged in and the proper drivers are 
installed.  The plastic portion of the lock is approximately 1 inch long. 

 

Installation 

General 

The steps necessary to install the Hardlock and HASP are described in detail in the following 
sections.  Installation procedures are divided into Single-User Locks and Network (Multi-
User) Locks sections to avoid confusion.   

The Single-User Locks section covers the installation of either the Parallel port or the USB 
version of the Hardlock and HASP that will be installed directly on the computer onto which 
the CINCINNATI software is being installed. 

The Network (Multi-User) Locks section covers installation of the Parallel port and USB 
Network  Hardlock  and HASP that will be installed on only one computer in a network. 

 

Single-User Locks 

The Single-User Hardlock comes in either a Parallel port or USB configuration.  The Single-
User HASP is available only in the USB configuration. 

 

Note:  It is especially important that you install the hardware drivers prior to connecting the 
lock if you are using the USB lock. 

Driver Installation 

The same driver works for both the Hardlock and HASP devices. 

Automatic - Driver installation is usually accomplished automatically upon installation of the 
CINCINNATI software.   

Manual - If the CINCINNATI installation program was not used or an updated driver needs to 
be installed: 

Locate the HASPUserSetup.exe file.  Using Windows Explorer or My Computer, locate the 
driver file.  This may be on a floppy disk, CD-ROM, or in a folder on your computer's hard 
drive. 
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Close any other open applications. 

Double-click on the HASPUserSetup.exe file. 

A Wizard-style installation dialog will appear and guide you through the installation 
procedure.    

Hardware Installation 

There are two types of hardlock keys available. 

Parallel Port 

Make sure the arrowhead is oriented toward the computer  

 

Connect the Hardlock to the Parallel port of the PC onto which the software application was 
installed. 

USB 

Note:  It is especially important that you install the hardware drivers prior to connecting the 
lock if you are using the USB Hardlock or HASP. 

    

Connect the USB lock to an enabled USB port on the PC onto which the software application 
was installed.  If the lock is installed properly and Windows finds the correct driver, a LED 
inside of the lock should light. 

Network (Multi-User) Locks 

Installation of the Network lock involves: 

- Driver and server software installation on the 'Server' 

- Hardware installation on the chosen 'Server'. 

- Installation of the CINCINNATI software on each 'Client' PC.  This will automatically 
install the necessary drivers on each Client. 

 

The Network lock tracks concurrent users of the CINCINNATI software.  Therefore, a 10-User 
license will allow 10 users to be running the software at the same time.  The CINCINNATI 
software can be installed on more than 10 computers but only 10 users can use the software 
concurrently. 
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A few terms need to be introduced regarding the Network Lock: 

Server – in this context: this is the computer that serves licenses for the protected software.  
This may or may not be an actual network server for your network.  It does not need to a 
server version of Windows,  regular Windows 2000 or XP will work fine.   

It is important to remember that the PC that is to be the lock server will need to be powered 
On to allow users to access the hardware lock. 

Client – in this context:  this is the computer that requests a license for the protected 
software. 

 

Driver Installation 

Hardlock Server 

Automatic Installation 

From the Network Hardlock installation disk, double-click on the 'HLServerSetup.exe' icon.  
This will install and start the necessary Service for NT/2000/XP or will install, start, and add to 
the Startup folder the necessary Application for Windows 98/ME. 

The installation program will also install the 'Aladdin Monitor' program.  This program can be 
used to monitor Network Hardlocks and the users attached to them. 

Manual Installation 

On the Server PC, the HL-Server Application (Win 98,ME) or Service (Win NT, 2000, XP) 
must be installed and started. 

Which HL-Server should be used on which operating system ? 

 

Operating 
System 

Installed 
As 

HL-Server to use Protocols 

Windows 
NT/2000/XP  

Service HLS32SVC.EXE (IPX, TCP/IP, 
NetBios) 

Windows 98/ME 32-bit App HLS32.EXE (IPX, TCP/IP, 
NetBios) 

NetWare 3.11+/4/5 
** 

NLM HLSERVER.NLM             (IPX, TCP/IP) 

** Call Cincinnati Incorporated 

Note:  You must be logged on as Administrator in order to install HL-Server under Windows 
NT/2000/XP.   

Start the HLSW32.EXE installation program. 

Follow the instructions of the installation Wizard.  The program will install the HL-Server 
application and the Hardlock drivers. 

You can use the 'Aladdin Diagnostic' program to test the installation. 

HASP Server 

From the installation CD, select the “Install Network HASP Server Software” option or 
download the  HaspServerSetup.exe from the CINCINNATI website.  This will install and start 
the necessary Service for 2000/XP. 
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The installation program will also install the 'Aladdin Monitor' program.  This program can be 
used to monitor Network Hardlocks and the users attached to them. 

 

Client 

Automatic - Driver installation is usually accomplished automatically upon installation of the 
CINCINNATI software on each Client PC.   

Manual - If the CINCINNATI installation program was not used or an updated driver needs to 
be installed: 

Locate the HASPUserSetup.exe file.  Using Windows Explorer or My Computer, locate the 
driver file.  This may be on a floppy disk, CD-ROM, or in a folder on your computer's hard 
drive. 

Close any other open applications. 

Double-click on the HASPUserSetup.EXE file. 

A Wizard-style installation dialog will appear and guide you through the installation 
procedure.    

Hardware Installation 

Parallel Port 

Make sure the arrowhead is oriented toward the computer  

 

USB 

Note:  It is especially important that you install the hardware drivers prior to connecting the 
lock if you are using the USB Hardlock or HASP. 

    

Connect the USB lock to an enabled USB port on the PC onto which the server software was 
installed.  If the lock is installed properly and Windows finds the correct driver, a LED inside 
of the lock should light.  
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Troubleshooting 

Single User Hardlock Troubleshooting 

Hardlock Module not found 

This fault may be caused by any of several problems.  Check the following aspects step-by-
step to solve the problem. 

Is the hardware installed correctly? 

Check the connection between the Hardlock module and the computer.  Make sure the 
Hardlock is pushed completely in. 

If the Hardlock module is connected to the computer via an extension cable, try connecting 
the module directly to the computer. 

If there are multiple modules from different software vendors attached to the parallel port, 
attach the CINCINNATI Hardlock first. 

Are the drivers installed? 

Check the driver version number using the Aladdin Diagnostic program.  (See the Aladdin 
Diagnostics Help for instructions.) 

If necessary, install the latest drivers provided by CINCINNATI.  (See the Driver Installation 
section of either the Single-User or Network Hardlock sections of this manual.) 

Is the parallel port set to Standard or Normal? 
Note:  This only applies to Parallel port modules. 

If using a parallel port Hardlock, the communication to the Hardlock can be disrupted if the 
parallel port is set to ECP mode.   In the BIOS, check which mode the parallel port is set to.  
Change the setting to Standard, SSP, or Normal. 

If the parallel port setting is determined to be the problem and setting the parallel port to non-
ECP mode is too limiting for other hardware which might use the same parallel port, consider 
using a USB module if possible. 

Automatic dial-up networking connection established 

If the computer attempts to establish a dial-up networking connection when the Hardlock 
module is accessed,  this indicates that the Hardlock was not found locally and the HL-Server 
could not be resolved. 

If this is a Single-User Hardlock implementation, then the local Hardlock cannot be found.  
Follow the steps in the Hardlock Module not found section above. 

If this is a Network Hardlock implementation: 

On the client computer, open the HOSTS file in the WINNT/SYSTEM32/DRIVERS/ETC folder 
(under Windows NT) or in the WINDOWS folder (under Windows 98) and insert the following 
line: 

 <IP address of the HL-Server computer> HLSERVER 

Printer attached to Hardlock parallel port does print correctly 
Note:  This only applies to Parallel port modules. 
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In the BIOS, check which mode the parallel port is set to.  Change the setting to Standard, 
SSP, or Normal. 

If the parallel port setting is determined to be the problem and setting the parallel port to non-
ECP mode is too limiting for the attached printer using the same parallel port, consider using 
a USB module if possible. 

 

Network Hardlock Troubleshooting 

General 

Check that the Server PC is turned On. 

Check that there are available licenses.  If the Hardlock is a 10-User version, are there 10 
users already running the software?  If so, one must exit the CINCINNATI software before a 
new user can run the software. 

Can the client PC see the Server PC on the network?  Try browsing to a shared folder on the 
server from the client or trying pinging the server.   

Are the Environment Variables set correctly? 
Note:  Environment Variables are typically accessed via the Control Panel, System 
applet, on the Advanced tab. 

The Hardlock driver should automatically search for network locks when no local locks are 
found.   However, with some networks, it may be necessary to help the driver locate the 
server before it times out.  This is done with two environment variables that can set on the 
client computers:  HL_SEARCH and HLS_IPADDR. 

The environment variable HL_SEARCH should be set to IP to tell the driver to search only for 
network locks, don’t bother looking locally.   

The environment variable HLS_IPADDR should be set to either the IP address (ex: 
192.168.10.5) or the computer name of the server (ex: ENGSERVER).  The IP address 
should only be used if it is a fixed address and DHCP is not being used on the server. 

For more information on Environment Variables see Aladdin Diagnostics Help. 

HLSAdmin 

A Network Hardlock Administration Program is included on the distribution disk for 
administration of the Multi-User (Network) Hardlocks.  This program is applicable to Multi-
User (Network) Hardlocks installed on Windows NT/2000/XP computers only. 

See the Hlsadmin.hlp file for more information. 

Single User HASP Troubleshooting 

HASP Module not found 

This fault may be caused by any of several problems.  Check the following aspects step-by-
step to solve the problem. 

Is the hardware installed correctly? 

Check the connection between the HASP module and the computer.  Make sure the HASP is 
pushed completely in. 

If the HASP lock is plugged into a USB hub, try bypassing the hub and plug the lock directly 
into the computer. 
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Are the drivers installed? 

Check the driver version number using the Aladdin Diagnostic program.  (See the Aladdin 
Diagnostics Help for instructions.) 

If necessary, install the latest drivers provided by CINCINNATI.  (See the Driver Installation 
section of either the Single-User or Network Hardlock sections of this manual.) 

 

Network HASP Troubleshooting 

General 

Check that the Server PC is turned On. 

Check that there are available licenses.  The Network HASP is a 10-User version, are there 
10 users already running the software?  If so, one must exit the CINCINNATI software before 
a new user can run the software. 

Can the client PC see the Server PC on the network?  Try browsing to a shared folder on the 
server from the client or trying pinging the server.   

Setup a NETHASP.INI file 

The HASP driver should automatically search for network locks when no local locks are 
found.   However, with some networks, it may be necessary to help the driver locate the 
server before it times out.  With the network HASP, this is done with a configuration file called 
NETHASP.INI located in the clients application directory, Windows directory, or 
Windows\System32 directory.  A sample NETHASP.INI file can be downloaded from the 
CINCINNATI website.  The contents of this file are shown below: 

[NH_COMMON] 

;; This NetHASP.INI file is configured to TCPIP.  

;; Please enter the address of the machine which  

;; the NetHASP key is connected to 

 

NH_TCPIP = Enabled;  ; Use the TCP/IP protocol 

 

[NH_TCPIP] 

 

NH_SERVER_ADDR = xx.xx.xx.xx; ; IP addresses of all the NetHASP  

     ; License Managers you want to search. 

     ; Unlimited addresses and multiple 

     ; lines are possible. 

     ; 

     ; Possible address format examples: 

     ; IP address:      192.114.176.65 

     ; Local Hostname:  ftp.aladdin.co.il 

 

NH_TCPIP_METHOD = UDP  ; Send a TCP packet or UDP packet 
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     ; Default:  UDP 

 

     ; Note: HASP API v8.x supports UDP, 

     ; it doesn't support TCP. 

 

NH_USE_BROADCAST = Enabled   ; Use TCPI/IP Broadcast 

mechanism. 

 

The NETHASP.INI file should be edited with the actual server address in the 
NH_SERVER_ADDR line.   Once edited, copy the NETHASP.INI file to the each client 
computer that is having difficulty locating the server. 

AKS Monitor 

When the Network HASP server software is installed on the server computer, the AKS 
monitor program is also installed.  This software allows the user to see how many network 
licenses are being used and which computers are using the licenses.  It also allows the user 
to stop/start the network license service on the server computer. 

Font File Definition 

Overview 
This section describes the font file format used by the CINCINNATI Laser Programming and 
Nesting software.  Customers can edit existing fonts or create new fonts of their own.  Basic 
knowledge of XML files will be helpful in understanding this information. 

 

The font files are XML text files located in the “Fonts” folders under the main nesting folder.  
Normally this is “C:\Program Files\Cincinnati Incorporated\LaserNst\Fonts”.  The 
CINCINNATI software ships with one font called “SimpleFont.xml”.  The name of the file 
without the “.xml” extension is used as the font name in the CINCINNATI software. 

 

The basic font file format is as follows: 

 

<?xml version="1.0" encoding="utf-8" ?> 

<font name="FontABCD" width=".8" height="1.0"> 
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 <letter char="1" startX=".4105" startY=".4885"> 

  <vec type="1" flags="1" feed="-10" x=".474" y=".4885"/> 

  …. (more “vec” nodes can follow) 

 </letter> 

 …..   (more “letter” nodes can follow) 

</font>   

 
 

font Node 

There can only be one <font> node per file and it must be the root node.  Each font must be 
defined in a separate file.  There is no limit to the number of font files located in the Fonts 
folder.  

<font name="FontABCD" width=".8" height="1.0"> 

name attribute – This attribute is an optional reference to the font name.  It is not 
necessary, the actual filename determines the font name displayed in the CINCINNATI 

software. 

width attribute – This attribute specifies the character spacing of the font in inches.  All 

characters in the font use the same spacing.  This will be scaled based on the actual height 
of the text and the height specified in the height attribute below.  

height attribute – This attribute specifies the height of the font in the font file and is 

normally set to “1.0” (inches).  The actual size of the text used on a part can be changed 
later but this value is used to scale the geometry in the font file.  For example, if the height 

attribute is set to 1.0 and text is added to a part using this font and the text height is set to 
2.5”, all the geometry in the font file will be scaled by a factor of 2.5.   

 

letter Node 

Each letter defined in the font is specified in it’s own node.  It is not necessary for a font file to 
define every possible character, but only the characters defined can be used on a part.  For 
example, the SimpleFont supplied with the CINCINNATI software does not contain lower 
case letters so lower case letters can not be used in text that uses SimpleFont.  The order of 
the letter nodes in the font file does not matter, they do not need to be in alphabetic order.  

<letter char="1" startX=".4105" startY=".4885"> 

char attribute – This attribute specifies the character that the letter will define.  It can be 

alphabetic, numeric or special character.   

startX attribute – The specifies the starting X value of the character.  

startY attribute – This specifies the starting Y value of the character. 
 

vec Node 

Each letter is defined by one or more vectors defined in vec nodes.  Ordering of the vec 
nodes is significant.  The first vec node is the first vector in the character, the second vec 
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node is the second vector, etc.   Vectors can be either lines or arcs with the laser beam on, or 
lines with the beam off. 

<vec type="1" flags="1" feed="-10" x=".474" y=".4885"/> 

type attribute – This attribute specifies the type of vector.  It can be either: 

0 – Linear move with the beam off (G00) 

1 – Linear move with beam on (G01) 

2 – Clockwise circular arc with beam on (G02) 

3 – Counter-clockwise circular arc with beam on (G03)  

flags attribute – This optional attribute specifies special functions that will be be preformed 
at the end of the vector.  These can be combined if necessary.  The possible values are: 

1 – Exact Stop (G09) 

2 – Optional Gas (M67) 

4 – Optional Standoff (M45) 

8 – Z Axis Servo Hold (M36) 

If this attribute is missing, a value of 0 is assumed.  To define multiple functions at the end 

of one vector, just add the above values together.  For example, to define an Exact Stop and 
a Optional Standoff on the same vector, the flags attribute should be set to “5”  (1 + 4). 

feed attribute – This optional attribute specifies the feedrate of the vector.  A negative value 
defines a percentage of the process feedrate and a postive value defines an absolute 

feedrate.  For example feed=”-40” would define a feedrate of 40% of the process feedrate 
while feed=”40” would define a feedrate of 40 IPM.  A value of 0 or no feed attribute at all 

results in the process feedrate being used for the vector. 

x attribute – This attribute is the X end point of the current vector.   

y attribute – This attribute is the Y end point of the current vector. 

xC attribute – This attribute is the X coordinate of the center of the arc and is only necessary 
for type=”2” and type=”3” vectors.  This is always an absolute coordinate. 

yC attribute – This attribute is the Y coordinate of the center of the arc and is only necessary 
for type=”2” and type=”3” vectors.  This is always an absolute coordinate. 
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Example 
 The following example is the letter ‘B’ from the SimpleFont font. 

 

 

The <letter> node for the ‘B’ character is shown below: 

 

<letter char="B" startX=".1" startY="0">      (Point 1) 

<vec type="1" flags="1" x=".1" y="1.0"/>      (Point 2) 

<vec type="1" x=".45" y="1.0"/>        (Point 3) 

<vec type="2" x=".45" y=".5" xC=".45" yC=".75"/> (Point 4) 

<vec type="1" x=".1" y=".5"/>        (Point 5) 

<vec type="0" x=".45" y=".5"/>        (Point 6) 

<vec type="2" x=".45" y="0" xC=".45" yC=".25"/>   (Point 7) 

<vec type="1" x=".1" y="0"/>         (Point 8) 

</letter> 

 

Notice that the character is defined in a 0.8” wide by 1.0” high rectangle.  This size is 
specified in the <font> node with the width and height attributes.   All characters defined in a 
font are defined using a coordinate system with the (0.0, 0.0) location in the bottom left 
corner. 
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Communications 

Overview 
The most common way that NC programs are sent to CINCINNATI Laser Systems equipped 
with a FANUC control (CL-5, CL-6, CL-7, and CL-7A) is using serial communications.  The 
CINCINNATI Programming and Nesting software does not have built in communications 
software however Windows 95, Windows 98 and Windows NT all come with a 
communications package called Hyperterminal.  The following sections describe how to use 
this software to send and receive files from the PC to the CINCINNATI Laser System. 

Setup 
To properly setup serial communications, you should know the baud rate, data bit, stop bit 
and parity your control is using.  Typically the FANUC control ships from CINCINNATI 
INCORPORATED as 4800 baud, 7 data bits, 2 stop bits and even parity.  You will also need 
to know the COM port your computer is using. 

Load Hyper Terminal by clicking on its icon.  The icon can be found in the Programs / 
Accessories menu using the Start button.  

You should now see the New Connections dialog box.  Type in FANUC as the name and 
select an ICON to represent the session.  Press the OK button when finished. 

Next the Phone Number dialog box will appear: 
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 Do not enter any information in the phone number box as it is not needed.  The connection 
we will be using is called Direct Connect.  This type of connection tells the computer that 
there will be no modem between itself and the device which it is communicating with.  
Depending on the COM port you will be using, select the appropriate direct connection port 
and press OK.  

You will now see the Port Settings dialog box: 
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 In this box, you will enter the specific information pertaining to how the FANUC is set to 
receive and transmit data.  You will also need to set the flow control to Xon / Xoff.  Press OK 
when you have finished.   

Now, select the File menu and click on  Properties.  This will bring up the properties dialog 
box.  We have already set up the connection properties, so click on the settings tab.  In the 
settings box, select TTY for the emulation.  Now press the ASCII setup button, the following 
dialog will appear: 

 

 In this box, you will need to place a check in the box next to ‘Send line ends with line feeds’.  
Press the OK button for both dialog boxes.  Please click on the File menu and select Save.  
This concludes the setup portion of this procedure. 

Sending Files 
 

In this section we will walk through the procedures needed to transmit a file from the PC to 
the FANUC control.  Hyper Terminal works well in this area, and does not require a lot of 
setup once the initial setup procedure has been completed and saved.  Simply double click 
on the FANUC icon in the Hyper Terminal directory and the setup information is loaded.  
Please note:  You MUST complete the setup procedure before sending any files. 

1) Load Hyper Terminal using the FANUC profile setup created earlier. 

2) Select the Transfer menu and click on ‘Send Text File’. 
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3) Select the drive, directory and file you wish to send.  Do not double click the file.  We don’t 
want to initiate the send routine just yet. 

4) Prepare the FANUC control to receive a file.  The FANUC should now be flashing LSK in 
the lower right corner of the screen. 

5) Press the OPEN button to initiate the send routine.  The FANUC control should now be 
flashing INPUT in place of LSK.  

6) Please note:  To successfully send a text file with this or any other method, a percent sign 
MUST be the absolute first, and last character in the text file.  The percent sign acts as a flag 
to instruct the FANUC control to start then stop the communications session. 

 

Receiving Files 
 

In this section we will walk through the procedures needed to receive a file from the FANUC 
control to the PC.  Hyper Terminal does not work well in this area, and can be a bit confusing 
at times.  To begin, double click on the FANUC icon in the Hyper Terminal directory and the 
setup information will be loaded.  Please note:  You MUST complete the setup procedure 
before receiving any files. 

1) Load Hyper Terminal using the FANUC profile setup created earlier. 

2) Select the Transfer menu and click on ‘Capture Text’. 

3) The dialog box, shown below, will be displayed.  Here is the confusing part, do NOT select 
browse unless you wish to append the received data into an existing file.  If you wish to 
create a new file, you must enter the drive, path and filename into the ‘File’ text box.   Press 
Start when ready. 

 

4) Select the file you wish to output on the FANUC control and output it as normal.  OUTPUT 
will flash in the lower right corner of the FANUC control. 

5) When OUTPUT stops flashing, go to the Transfer menu, then the ‘Capture Text’ menu and 
select ‘Stop’.  This will save the captured text into the file selected in step 3.
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